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ABSTRAKSI

Pegy Fortuna Adam (NIM: 0101.1801.120). “PENGARUH PENGGUNAAN
METODE BERNYANYI DALAM MENINGKATKAN HASIL BELAJAR PAI
SISWA (DI SDN KARANGANYAR 1 KELAS V DESA KARANGANYAR
KECAMATAN KLARI KABUPATEN KARAWANG)”

Penelitian ini berlatar belakang pada rendahnya tingkat pemahaman siswa
dalam mata pelajaran Pendidikan Agama Islam kelas V di SDN Karanganyar 1
sehingga menyebabkan hasil belajar siswa kurang maksimal. Tujuan dari
penelitian ini adalah untuk mendeskripsikan pengaruh penggunaan metode
bernyanyi dalam meningkatkan hasil belajar siswa dalam mata pelajaran PAI.
Metode bernyanyi merupakan metode yang mengandung sebuah lagu. Dalam
proses pembelajarannya yaitu pendidik merangkai materi yang akan disampaikan
kepada siswa menjadi sebuah syair. Menurut Muhammad Fadillah, metode
bernyanyi merupakan salah satu metode yang dapat menumbuhkan minat,
menguatkan daya tarik pembelajaran, dan memberikan stimulus terhadap
pengetahuan siswa. Penelitian ini merupakan penelitian kuantitatif berjenis
eksperimen. Peneliti mengambil sampel kelas V yang terdiri atas kelas
eksperimen dan kelas kontrol yang masing-masing berjumlah 21 siswa. Penentuan
sampel menggunakan teknik random. Teknik pengumpulan data menggunakan
instrumen tes dan angket.

Dari hasil analisis data diperoleh: Pertama, Penggunaan metode bernyanyi dalam
pelajaran Pendidikan Agama Islam yaitu dengan mengubah materi menjadi
sebuah lagu yang dapat memudahkan siswa dalam memahami materi sehingga
siswa bisa merasakan pembelajaran yang menyenangkan dan meningkatkan hasil
belajar siswa. Hasil perolehan skor rata-rata pre-test dari kelas eksperimen 1.726 :
714 = 2,4. Sedangkan hasil skor rata-rata post-test 2.523 : 714 = 3,5. Adapun
perolehan skor rata-rata pre-test dari kelas kontrol ialah 1.756 : 714 = 2,4. Dan
skor rata-rata post-test 1.783 : 714 = 2,49. Kedua, sebelum menggunakan metode
bernyanyi diperoleh t hitung 1.713 < 2.093 dengan nilai sig. 0.094 > 0.05, maka
dapat disimpulkan bahwa tidak terdapat perbedaan yang signifikan skor Pre-Test
antara kelas eksperimen dan kelas kontrol. Ketiga, setelah menggunakan metode
bernyanyi diperoleh t hitung 10,449 > 2,093 dengan nilai sig. 0,000 < 0.05, maka
dapat disimpulkan bahwa terdapat perbedaan yang signifikan skor Post-Test
antara kelas eksperimen dan kelas kontrol. Keempat, tingkat efektivitas hasil
belajar siswa diketahui melalui N-Gain Score. Pada kelas eksperimen diperoleh
rata-rata N-Gain Score sebesar 79,1501 atau 79% termasuk dalam kategori efektif.
Sedangkan pada kelas kontrol diperoleh rata-rata N-Gain Score sebesar 19,9381
atau 19% termasuk dalam kategori tidak efektif.

Kata Kunci : Metode Bernyanyi, Hasil Belajar Siswa

XVi



BAB |
PENDAHULUAN

A. Latar Belakang

Metode dalam pembelajaran merupakan cara yang dapat digunakan
guru dalam menyajikan berbagai informasi kepada peserta didik untuk
dapat mencapai tujuan tertentu. Dengan adanya metode tentu dapat
mempermudah guru dan siswa pada saat kegiatan belajar mengajar.

Untuk mencapai hasil pembelajaran yang maksimal tentu
diperlukan adanya metode yang dapat memberikan dampak positif
teerhadap proses belajar sehingga pembelajaran tersebut dapat mencapai
tujuan pendidikan yang diharapkan.

Namun saat ini, fenomena yang terjadi ialah masih ada beberapa
pendidik yang kurang bervariasi dalam mengajar khususnya dalam mata
pelajaran PAI. Sehingga peserta didik beranggapan bahwa pembelajaran
PAI tidak menyenangkan dan pembelajaran PAI tidak berjalan secara
efektif. Maka, proses pembelajaran yang tidak efektif tersebut dapat
mempengaruhi hasil belajar siswa.

Dalam proses pembelajaran, metode merupakan peran penting
yang tidak dapat dihindari. Karena dengan adanya metode dalam proses
pembelajaran dapat mempengaruhi minat siswa dalam belajar. Tidak
hanya minat, tetapi dapat mempengaruhi hasil belajar siswa sehingga
tujuan pembelajaran dapat tercapai dengan sempurna.

Dewasa ini, masih terdapat pengguaan metode yang tidak sesuai
baik dalam hal pemilihan metode yang tidak sesuai dengan karakteristik
peserta didik, atau karena tidak adanya penggunaan metode Yyang
bervariasi sehingga menimbulkan peserta didik merasa malas dan bosan
dengan proses pembelajaran.

Berdasarkan observasi pra penelitian di SDN Karanganyar 1 yang
telah dilakukan ternyata kurangnya atau rendahnya hasil belajar siswa
dalam mata pelajaran PAIl yang dipengaruhi oleh tidak efektifnya
penggunaan metode pembelajaran yaitu dengan menggunakan metode

ceramah dapat dilihat dari hasil tes tulis terhadap siswa. Hasil dari tes



tersebut menunjukkan bahwa anak-anak di sekolah ini memang masih
rendah dalam memahami materi PAIl. Rendahnya pemahaman bisa
menyebabkan kurangnya hasil belajar siswa. Dengan demikian peneliti
rasa perlu adanya suatu perubahan metode. Peneliti berupaya agar dapat
meningkatkan pemahaman siswa serta hasil belajar siswa dengan
melakukan metode bernyanyi.

Dengan adanya metode bernyanyi dapat meningkatkan hasil
belajar siswa karena metode tersebut adalah salah satu metode yang
menyenangkan dan dapat menarik minat siswa sehingga menumbuhkan
motivasi dalam belajar. Ketika motivasi dalam belajar sudah ada tentu
dampaknya akan berpengaruh terhadap meningkatnya hasil belajar siswa.

Oleh karena itu, peneliti tertarik untuk meneliti “Pengaruh
Penggunaan Metode Bernyanyi dalam Meningkatkan Hasil Belajar
PAI Siswa di SDN Karanganyar 1 Kelas VV”. Dengan adanya metode
bernyanyi dapat menumbuhkan minat siswa dalam belajar sehingga
meningkatkan hasil pembelajaran siswa. Adapun lokasi penelitian ini
terletak di SDN Karanganyar 1 Karawang diambil karena lokasi penelitian
merupakan lokasi domisili peneliti yang menarik untuk diteliti.

B. Identifikasi Masalah

Adapun identifikasi permasalahan dalam penelitian ini yaitu
sebagai berikut:

1. Kurangnya penggunaan metode pelajaran PAI di SDN Karanganyar
1

2. Minimnya hasil pembelajaran siswa kelas V SDN Karanganyar 1

3. Kurangnya siswa dalam memahami pembelajaran PAI di SDN
Karanganyar 1

4. Minimnya minat pembelajaran PAI siswa kelas V di SDN
Karanganyar 1

C. Batasan Masalah

Dari beberapa identifikasi masalah di atas, maka peneliti akan

membatasi masalah dalam penelitian ini yaitu mengenai kurangnya

p;enggunaan metode dalam p;embelajaran dan minimnya hasil belajar



siswa dalam mata pelajaran PAI kelas V di SDN Karanganyar 1 tersebut
dan membuat judul penelitian “Pengaruh penggunaan metode bernyanyi
dalam meningkatkan hasil belajar PAI siswa di SDN Karanganyar 1 Kelas
AV
D. Rumusan Masalah
Berdasarkan fokus masalah di atas, maka dapat peneliti rumuskan
permasalahannya yaitu:
1. Bagaimana penggunaan metode bernyanyi dalam pelajaran PAI
kelas V di SDN Karanganyar 1?
2. Bagaimana hasil belajar siswa sebelum menggunakan metode
bernyanyi pada mata pelajaran PAI kelas V di SDN Karanganyar
1?
3. Bagaimana hasil belajar siswa setelah menggunakan metode
bernyanyi pada mata pelajaran PAI kelas V di SDN Karanganyar
1?
4. Bagaimana pengaruh metode bernyanyi terhadap hasil belajar
siswa pada mata pelajaran PAI kelas V di SDN Karanganyar 1?
E. Tujuan Penelitian
Tujuan penelitian yang hendak dicapai oleh peneliti ialah sebagai
berikut:
1. Untuk mengetahui penggunaan metode bernyanyi dalam pelajaran
PAI kelas V di SDN Karanganyar 1
2. Untuk mengetahui hasil belajar siswa sebelum menggunakan
metode bernyanyi pada mata pelajaran PAI kelas V di SDN
Karanganyar 1
3. Untuk mengetahui hasil belajar siswa setelah menggunakan
metode bernyanyi pada mata pelajaran PAI kelas V di SDN
Karanganyar 1
4. Untuk mengetahui pengaruh penggunaan metode bernyanyi
terhadap hasil belajar siswa pada mata pelajaran PAI kelas V di

SDN Karanganyar 1



F. Kegunaan Penelitian

Dalam melakukan penelitian ini di harapkan dapat memberi manfaat

baik secara teoritis maupun secara praktis.

1. Kegunaan teoritis

Hasil penelitian ini diharapkan dapat menambah pengetahuan

dan wawasan dalam bidang pendidikan mengenai penggunaan

metode bernyanyi dalam meningkatkan hasil belajar siswa pada

mata pelajaran PAI.

2. Kegunaan praktis

a.

Bagi guru

Dapat memberi masukan kepada guru terkait proses mengajar
perlu adanya penggunaan metode yang sesuai dengan
karakteristik siswa.

Bagi sekolah

Peneliti harap dapat dijadikan masukan dalam usaha
meningkatkan kualitas siswa, proses, dan terutama dalam hasil

belajar siswa.

. Bagi peneliti

Peneliti berharap penelitian ini dapat menjadikan wawasan dan
informasi  baru mengenai metode pembelajaran dapat
meningkatkan hasil belajar dan dapat menjadi bekal bagi penulis

untuk proses ke depannya.



BAB 11
KAJIAN TEORI

A. Deskripsi Teori
1. Metode Bernyamyi
a. Definisi Metode Bernyanyi

Dalam proses pembelajaran, metode merupakan hal yang sangat
penting untuk digunakan oleh guru. Metode yang berubah-ubah akan
membuat siswa menjadi bersemangat dan tidak merasa jenuh pada
kegiatan pembelajaran.

Metode merupakan cara yang dilakukan oleh guru dalam
menyampaikan, menyajikan, menguraikan, memberi contoh, dan
memberi latihan kepada siswa untuk mencapai tujuan tertentu
(Yamin, 2017). Metode adalah satu cara yang dipergunakan untuk
mencapai suatu tujuan pembelajaran yang telah ditetapkan
(Setiawan, 2017).

Dari beberapa pengertian metode di atas, maka dapat disimpulkan
bahwa metode merupakan upaya atau jalan yang digunakan oleh
pendidik dalam menyampaikan informasi atau materi kepada siswa
dengan tujuan untuk mempermudah siswa memahami materi
sehingga dapat mencapai tujuan pembelajaran secara maksimal.

Diperlukannya metode dalam proses pembelajaran tidak hanya
oleh siswa saja, guru juga memerlukan metode dalam
menyampaikan materi karena dengan adanya metode dapat
mempermudah guru dalam menyampaikan materi sehingga materi
tersebut dapat tersampaikan dengan baik.

Metode dapat membuat siswa lebih aktif pada saat proses
pembelajaran. Karena metode merupakan peranan yang sangat
penting dalam kegiatan belajar mengajar. Berhasil atau tidak
berhasilnya suatu pembelajaran itu tergantung pada metode yang
digunakan atau metode yang dipilih oleh guru pada saat

pembelajaran.



Dalam hal ini, tentu peran guru sangat penting dalam memilih
metode yang sesuai dengan materi yang akan disampaikan serta
karakteristik siswa agar penggunaan metode dapat berjalan dengan
baik sesuai harapan. Salah satu metode yang dapat digunakan guru
pada saat proses pembelajaran ialah metode bernyanyi.

Metode bernyanyi merupakan metode pembelajaran yang
menggunakan syair-syair yang dilagukan. Maksudnya syair-syair
disini adalah materi yang akan disampaikan oleh guru akan diolah
menjadi sebuah syair yang akan diajarkan. Menurut pendapat ahli,
bernyanyi membuat suasana belajar menjadi riang dan bergairah
sehingga proses perkembangan anak dapat distimulasi secara optimal
(Fadlillah, 2012).

Bernyanyi merupakan suatu kegiatan yang digemari oleh aak-anak.
hampir setiap anak menikmati lagu atau nyanyian yang mereka
dengarkan apalagi jika nyanyian tersebut dibawakan oleh teman
sejawatnya dan diikuti dengan tarian atau gerakan yang sederhana
(N1’'mah, n.d.).

Sedangkan menurut Depdikbud metode bernyanyi adalah metode
pengajaran Yyang dilakukan dengan cara berdendang dengan
menggunakan suara yang merdu dan nada yang enak didengar serta
kata-kata yang mudah dihapal sebagai salah satu upaya untuk
menyampaikan informasi atau pengetahuan.

Berdasarkan beberapa pendapat tersebut, maka dapat disimpulkan
bahwa metode bernyanyi merupakan metode pengajaran yang
digunakan oleh guru dalam proses pembelajaran dengan
menggunakan sayir-syair yang dilagukan sesuai dengan materi yang
akan diajarkan serta diiringi dengan suara yang merdu.

Setiap metode yang digunakan oleh guru pada kegiatan belajar
tentu memiliki manfaat. Adapun manfaat dari metode bernyanyi
menurut Honig dalam (Ridwan & Bangsawan, 2021) ialah:

1) Bersifat menyenangkan

2) Mengatasi kecemasan



3) Media untuk mengekspresikan perasaan
4) Membantu dan membangun rasa percaya diri
5) Mengembangkan keterampilan berfikir dan kemampuan motorik

6) Meningkatkan keeratan dengan sebuah kelompok

Syamsuri Jari yang dikutip oleh Setyoadi dalam (Fadlillah, 2012)
juga menyebutkan bahwa diantara manfaat penggunaan lagu

(menyanyi) dalam pembelajaran ialah:

1) Sarana relaksasi dengan menetralisasi denyut jantung dan
gelombang otak

2) Menumbuhkan minat dan penguatan daya tarik pembelajaran

3) Menciptakan proses pembelajaran lebih  humanis dan
menyenangkan

4) Sebagai jembatan dalam mengingat materi pembelajaran

5) Membangun retensi dan menyentuh emosi dan rasa estetika siswa

6) Proses internalisasi nilai yang terdapat pada materi pembelajaran

7) Mendorong motivasi belajar siswa.

b. Kelebihan dan Kekurangan Metode Bernyanyi

Setiap metode pembelajaran yang digunakan guru pada proses
pembelajaran tentu memiliki kelebihan dan kekurangan tersendiri. Tidak
terkecuali metode bernyanyipun tentu memiliki kelebihan dan kekurangan
di dalamnya. Adapun kelebihan dari metode bernyanyi antara lain ialah
dapat membantu siswa mengembangkan, memperbanyak kesiapan serta
dapat mengembangkan penguasaan keterampilan dalam proses kognitif
atau pengenalan sisiwa. Selain itu, metode ini mampu membangkitkan
semangat dan gairah belajar siswa, memberi kesempatan kepada siswa
untuk mampu berkembang dan maju sesuai dengan kemampuannya
masing-masing, serta mampu mengarahkan cara belajar siswa sehingga
dapat lebih memliki motivasi yang kuat untuk belajar lebih giat (Ridwan
& Awaluddin, 2019).

Pendapat lain ada yang menyatakan bahwa kelebihan metode

bernyanyi (Risaldy, 2014) ialah:



1)
2)
3)
4)

Meningkatkan motivasi anak dalam belajar
Metode bernyanyi sangat disenangi oleh anak-anak
Tidak membutuhkan media yang telalu sulit didapat

Metode ini dapat dilakukan dengan musik ataupun tanpa musik

Sedangkan Musbikin dalam (Ni’mah, n.d.) dijelaskan bahwa

kelebihan metode bernyanyi adalah:

1)

2)

3)

4)
5)

6)

7)

8)

9)

10)

11)

Memperkaya atau menambah sumber belajar bagi guru dan anak
usia dini.

Memotivasi guru untuk lebih kreatif dalam mengoptimalkan
lingkungan sekitar untuk dijadikan sebagai media pembelajaran.
Meningkatkan kreativitas guru dalam menciptakan metode
pembelajaran yang menarik dan menyenangkan untuk anak usia
dini.

Materi pembelajaran akan menjadi lebih menarik dan konkret.
Untuk anak didik, diharapkan dapat merangsang kemampuan
penalarannya, penciptaan, perkembangan daya pikir,
perkembangan bahasa, berimajinasi dan kreativitas

Membantu anak untuk mengembangkan pengetahuan dan
ketrampilan baru yang didasarkan pada hal-hal yang telah anak
ketahui dan yang ingin diketahui anak.

Bernyanyi harus menyediakan konsep yang dapat diselidiki oleh
setiap anak melalui pengalaman praktik langsung tentang objek-
objek yang nyata bagi anak untuk menilai dan memanipulasinya.
Bernyanyi dapat disesuaikan dengan tema, materi dan kegiatan
yang berlangsung.

Anak menjadi aktif terlibat di dalam kegiatan, sehingga anak
akan menggunakan semua pemikirannya.

Hasil yang capai dari penerapan metode bernyanyi secara tidak
langsung menghasilkan produk kreativitas.

Guru dapat memberikan kesempatan kepada anak untuk

merefleksikan apa yang telah anak ketahui.



12)

Meningkatkan kemandirian, harga diri yang positif (percaya
diri).

Sedangkan kekurangan dari metode bernyanyi ini adalah sebagai
berikut:

1)
2)

3)

Sulit jika digunakan pada kelas yang terlalu besar

Jika siswa pendiam dan tidak suka bernyanyi, maka hasilnya
akan kurang efektif

Suasana kelas yang terlalu ramai dapat mengganggu kelas yang
lain (Ni’mah, n.d.).

. Langkah- langkah Metode Bernyanyi

Agar proses penggunaan metode bernyanyi dapat berjalan secara

maksimal maka terlebih dahulu kita harus menetapkan langkah-

langkah dalam pelaksanaannya. Adapun langkah-langkah metode

bernyanyi menurut Depdiknas dalam (Marlina, 2015) adalah sebagai
berikut:

1)

2)
3)

4)
5)
6)
7)
8)
9)

10)

11)

Guru membicarakan isi nyanyian yang akan diajarkan melalui
tanya jawab guru pada anak

Guru menyanyikan lagu secara keseluruhan dua atau tiga kali
Guru dan anak menyanyikan lagu bersama-sama, makin lama
suara guru makin pelan

Guru dan anak menyanyikan lagu dengan bersenandung

Guru membacakan syair baris demi baris dan diikuti oleh anak
Guru menjelaskan kata-kata yang sukar

Guru dan anak menyanyikan lagu bersama-sama

Guru memberikan kesempatan pada anak yang sudah dapat dan
mau menyanyikan sendiri atau dengan beberapa teman untuk
maju ke depan kelas

Guru memberi bimbingan, dorongan pada anak yang
memerlukan

Guru memberi pujian secara tepat pada waktunya agar anak
memperoleh kegembiraan

Guru dan anak menyanyikan lagu lain sebagai selingan
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12) Guru dan anak menyanyikan kembali lagu tersebut.
2. Hasil Belajar
a. Definisi Hasil Belajar

Dalam proses pendidikan, tentu di dalamnya terdapat hasil belajar
sebagai ciri atau tanda bahwa pelaksanaan proses pembelajaran
tersebut telah dilaksanakan dan memperoleh hasil belajar.

Hasil belajar adalah suatu kemampuan yang yang diperoleh oleh
peserta didik setelah ia menerima rangkaian proses pembelajaran
(Sudjana, 2009b). Hasil belajar merupakan bukti keberhasilan belajar
atau kemampuan siswa dalam proses belajarnya sesuai dengan bobot
yang dicapainya (Rodin & Sunenti, 2017). Hasil belajar siswa ialah
salah satu alat ukur untuk melihat pencapaian seberapa jauh siswa
dalam menguasai materi pelajaran yang telah disampaikan oleh guru
(Wirda et al, 2020). Hasil belajar pada hakikatnya adalah
perubahan-perubahan tingkah laku siswa berupa pengetahuan,
keterampilan dan sikap yang terjadi setelah melaksanakan
serangkaian proses pembelajaran.

Hasil belajar memiliki peranan yang sangat penting dalam proses
pembelajaran. Karena untuk mengetahui keberhasilan proses
pembelajaran tentu pendidik harus mengetahui seberapa jauh
keefektifannya dalam mengubah tingkah laku para siswa ke arah
tujuan pendidikan yang diharapkan.

Menurut Poerwanto dalam (Rodin & Sunenti, 2017) menjelaskan
bahwa hasil belajar ialah suatu prestasi yang diperoleh oleh siswa
dalam usaha belajar sebagaimana yang dinyatakan dalam nilai
raport. Hasil belajar merupakan sejumlah pengalaman yang
diperoleh siswa pada proses pembelajaran yang mencakup ranah
kognitif, efektif dan psikomotorik (Fauhah, 2021).

Ahmad Susanto dalam (Yudha, 2013) mengemukakan bahwa hasil
belajar adalah tingkat keberhasilan siswa yang dicapai dalam proses
mempelajari materi pelajaran yang dinyatakan dalam skor yang

diperoleh dari hasil tes mengenai sejumlah materi pelajaran tertentu.
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Berdasarkan beberapa penjelasan diatas, maka hasil belajar
merupakan suatu perubahan yang dialami siswa selama mengikuti
proses pembelajaran. Perubahan tersebut berupa perubahan tingkah
laku, pengetahuan, dan sikap. Hasil belajar dapat digunakan pendidik
untuk dijadikan tolak ukur atau kriteria dalam mencapai tujuan
pembelajaran. Hal tersebut dapat dicapai apabila siswa mampu
memahami pelajaran sehingga dapat merubah tingkah lakunya ke
arah yang lebih baik.

. Faktor yang Mempengaruhi Hasil Belajar

Dalam kegiatan proses belajar siswa, tentu terdapat beberapa faktor
yang mempengaruhi hasil belajar siswa baik itu dari lingkungan
keluarga ataupun lingkungan sekolah.

Keberhasilan dalam proses pembelajaran dapat dipengaruhi oleh
beberapa faktor baik faktor internal maupun faktor eksternal. Faktor
internal terdiri dari:

a) Motivasi
b) Kepercayaan diri

c) Kireativitas guru itu sendiri.

Sedangkan faktor eksternal lebih di tekankan pada sarana serta iklim

sekolah yang bersangkutan (Lestari, n.d.).

Adapun foktor-faktor yang dapat mempengaruhi hasil belajar siswa
menurut Slameto dalam (Marlia & Sholehun, n.d.) ialah terbagi
menjadi dua bagian yaitu yang pertama faktor internal atau yang ada
pada diri siswa didalamnya terdiri dari jasmani dan psikologi,
sedangkan yang kedua faktor eksternal atau yang diluar diri siswa

terdiri dari keluarga, sekolah dan masyarakat.

Sedangkan Syah berpendapat bahwa faktor-faktor yang
mempengaruhi hasil belajar yang merujuk pada teori belajar kognitif
dibagi kedalam tiga kelompok, yakni faktor internal, faktor
eksternal, dan faktor pendekatan belajar yang digunakan. Semua

faktor-faktor tersebut saling berkaitan satu sama lain.
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Dari beberapa uraian diatas, maka dapat disimpulkan bahwa

faktor-faktor yang dapat mempengaruhi hasil belajar siswa secara

garis besar terbagi menjadi dua bagian, yaitu faktor internal dan

faktor eksternal.

. Indikator Hasil Belajar

Untuk melihat ketercapaian tujuan pembelajaran, perlu adanya

indikator hasil belajar. adapun hasil belajar menurut Nana Sudjana
(Sudjana, 2009a) ialah:
1) Ranah Kognitif

Dalam ranah ini berhubungan dengan intelektual yang tediri dari

enam aspek yaitu :

Pengetahuan atau ingatan (C1)

Istilah pengetahuan dimaksudkan sebagai terjemah dari kata
knowledge dalam taksonomi Bloom. Sekalipun demikian,
maknanya tidak sepenuhnya tepat sebab dalam istilah
tersebut termasuk pula pengetahuan faktual disamping
pengetahuan hafalan atau untuk diingat seperti rumus,
batasan, definisi, pasal dalam undang-undang, nama-nama
tokoh, nama-nama negara. Dilihat dari segi proses belajar,
istilah-istilah tersebut memang perku dihapal dan diingat
agar dapat dikuasainya sebagai dasar bagi pengetahuan atau
pemahaman konsep-konsep lainnya.(Sudjana, 2009a)
Pemahaman (C2)

Tipe hasil belajar yang lebih tinggi daripada pengetahuan
adalah pemahaman. Misalnya menjelaskan dengan susunan
kalimatnya sendiri sesuatu yang dibaca atau didengarnya,
memberi contoh lain dari yang telah dicontohkan, atau
menggunakan petunjuk penerapan pada kasus lain.

Aplikasi (C3)

Aplikasi adalah penggunaan abstraksi pada situasi kongkret
atau situasi khusus. Abstraksi tersebut mungkin berupa ide,

teori, atau petunjuk teknis. Menerapkan abstraksi ke dalam
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situasi  baru  disebut  aplikasi. = Mengulang-ulang
menerapkannya pada situasi lama akan beralih menjadi
pengetahuan hafalan atau keterampilan.

Analisis (C4)

Analisis adalah usaha memilah suatu integritas menjadi
unsur-unsur atau bagian-bagian sehingga jelas hierarkinya
atau susunannya. Analisis merupakan kecakapan yang
kompleks, yang memanfaatkan kecakapan dari ketiga tipe
sebelumnya.

Sintesis (C5)

Penyatuan unsur-unsur atau bagian-bagian ke dalam bentuk
menyeluruh disebut sintesis. Berpikir sintesis merupakan
salah satu terminal untuk menjadikan orang lebih kreatif.
Berpikir kreatif merupakan salah satu hasil yang hendak
dicapai dalam pendidikan.

Evaluasi (C6)

Evaluasi adalah pemberian keputusan tentang nilai sesuatu
yang mungkin dilihat dari segi tujuan, gagasan, cara
bekerja, pemecahan, metode, materil, dll. Dilihat dari segi
tersebut maka dalam evaluasi perlu adanya suatu kriteria

atau standar tertentu.

2) Ranah Afektif

Dalam ranah ini berhubungan dengan sikap yang terdiri dari

lima aspek yaitu:

Penerimaan

Kepekaan dalam menerima rangsangan (stimulus) dari luar
yang datang kepada siswa dalam bentuk masalah, situasi,
gejala, dll. Dalam tipe ini termasuk kesadaran, keinginan
untuk menerima stimulus, kontrol, dan seleksi gejala atau
rangsangan dari luar.

Jawaban atau reaksi
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Reaksi yang diberikan oleh seseorang terhadap stimulus
yang datang dari luar. Hal ini mencakup ketepatan reaksi,
perasaan, kepuasan dalam menjawabstimulus dari luar yang
akan datang kepada dirinya.

Penilaian

Berkenaan dengan nilai dan kepercayaan terhadap gejala
atau stimulus tadi. Dalam evaluasi ini termasuk didalamnya
kesediaan menerima nilai, latar belakang, atau pengalaman
untuk menerima nilai dan kesepakatan terhadap nilai
tersebut.

Organisasi

Pengembangan dari nilai ke dalam satu sistem organisasi,
termasuk hubungan satu nilai dengan nilai lain,
pemantapan, dan prioritas nilai yang telah dimilikinya.
Internalisasi

Keterpaduan semua sistem nilai yang telah dimiliki
seseorang, yang mempengaruhi pola kepribadian dan
tingkah lakunya. Ke dalamnya termasuk keseluruhan nilai

dan karakteristik.

3) Ranah Psikomotorik

Dalam ranah ini berhubungan dengan hasil belajar keterampilan

dan kemampuan bertindak terdiri dari enam aspek yaitu:

Gerakan refleks adalah keterampilan pada gerakan yang
tidak disadari.

Keterampilan gerakan dasar

Kemampuan perseptual yang termasuk di dalamnya
membedakan visual, membedakan auditif, motoris, dan
lain-lain.

Kemampuan di bidang fisik, misalnya kekuatan,
keharmonisan dan ketepatan.

Gerakan-gerakan skill, mulai dari keterampilan sederhana

sampai pada keterampilan yang kompleks.
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e Gerakan ekspresif dan interpretatif misalnya kemampuan

yang berkenaan dengan komunikasi non-decursive.

Ketiga ranah tersebut adalah hal penting dalam proses
pembelajaran, untuk melakukan evaluasi dan mengetahui sejauh
mana proses pembelajaran dilaksanakan sehingga melahirkan hasil
belajar siswa. Ranah kognitif berkenaan dengan kemampuan siswa
dalam menguasai dan memahami materi yang disampaikan oleh
guru. Ranah afektif berkenaan dengan perasaan, minat, perhatian,
keinginan, penghargaan. Sedangkan ranah psikomotorik berkenaan
dengan keterampilan atau kemampuan dalam bertindak setelah

menerima pengalaman belajar.

3. Pendidikan Agama Islam (PAI)
a. Definisi Pendidikan Agama Islam

Dalam Kamus Besar Bahasa Indonesia (KBBI) edisi V, pendidikan
berasal dari kata “didik” yang kemudian diberi awalan “pen” dan
akhiran “an” dan memiliki arti proses atau cara. Sedangkan arti
pendidikan ialah suatu proses mengubah sikap dan tata laku
seseorang atau kelompok untuk mendewasakan manusia melalui
pelatihan dan pengajaran. Pendidikan merupakan salah satu proses
pengembangan kemampuan diri sendiri sehingga dapat merubah
tingkah laku dan sikap melalui proses pembelajaran.

Muhaimin berpendapat dalam (Sulaiman, 2017), bahwa pendidikan
agama islam ialah upaya mendidikkan ajaran agama islam serta
nilai-nilai yang terkandung di dalamnya agar dapat menjadi
pandangan atau pedoman hidup seseorang.

Sedangkan Sayyid Sabiqg berpendapat bahwa pendidikan islam
adalah suatu perjalanan mempersiapkan diri seseorang dari berbagai
segi seperti segi jasmani, akal, dan rohani sehingga dapat menjadi
bagian dari anggota masyarakat yang memberikan manfaat bagi
dirinya dan orang lain (Abdullah, 2018).
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Di pihak lain, Dr. Muhammad Fadhil Al Jamali (Hidayat, 2016)
juga mengemukakan pendapat mengenai pendidikan islam ialah
salah satu upaya mengembangkan, mendorong, serta mengajak
manusia untuk lebih maju dengan berlandaskan nilai-nilai yang
tinggi dan kehidupan yang mulia, sehingga membentuk suatu pribadi
yang lebih baik dari segi akal, perasaan maupun perbuatan.

Dari beberapa pengertian diatas, maka dapat peneliti artikan bahwa
pendidikan agama islam merupakan proses mendewasakan diri
seseorang melalui bimbingan, pengajaran dan pelatihan dengan
ajaran islam sehingga mendapatkan perubahan tingkah laku serta
sikap yang lebih baik dan dapat bermanfaat baik untuk diri sendiri
maupun untuk orang lain.

. Tujuan Pendidikan Agama Islam

Tujuan merupakan sesuatu hal yang wajib ada dalam lembaga
pendidikan. Karena dengan adanya tujuan tentu akan mempermudah
dan memberi arahan kemana Kkita akan berjalan. Tujuan dapat
diartikan sebagai maksud yang akan dicapai setelah melakukan
serangkaian proses kegiatan yang telah dilalui. Pendidikan
merupakan suatu proses pembelajaran yang memiliki tujuan agar
seseorang dapat menjadi manusia yang dapat hidup dengan baik.

Tujuan adalah faktor yang sangat penting khususnya dalam
lembaga pendidikan. Karena apabila pendidikan tidak memiliki
tujuan di dalamnya tentu akan membuat proses pembelajaran yang
tidak tentu arahnya. Oleh karena itu penting adanya tujuan agar
proses pembelajaran dapat berjalan sesuai harapan dan mencapai
tujuan akhir.

Rahmat Hidayat dalam buku Ilmu Pendidikan Islam: Menuntun
Arah Pendidikan Islam Indonesia 2016, menyatakan bahwa tujuan
pendidikan islam tidak terlepas dari tujuan hidup manusia dalam
ajaran islam yaitu dapat menciptakan kepribadian hamba-hamba

Allah SWT vyang senantiasa bertagwa kepada-Nya, dan dapat
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menjalani kehidupan yang bahagia di dunia dan di akhirat (Hidayat,
2016).

Adapun M. Quraish Shihab berpendapat bahwa tujuan pendidikan
islam adalah membina manusia baik secara pribadi maupun
kelompok sehingga dapat menjalankan fungsinya sebagai hamba dan
khalifah, guna membangun dunia ini berdasarkan konsep yang telah
ditetapkan oleh Allah SWT (Abdullah, 2018).

Dengan demikian, peneliti mengambil kesimpulan bahwa tujuan
pendidikan islam ialah usaha mendidik, menumbuhkan dan
meningkatkan keimanan pribadi muslim agar senantiasa bertagwa
dan beribadah kepada Allah SWT sehingga memperoleh
kebahagiaan di dunia hingga di akhirat.

Indikator ketercapaian hasil belajar PAI siswa

Dalam melaksanakan pembelajaran tentunya mempunyai tujuan
yang harus dicapai. Untuk mencapai tujuan tersebut tentunya harus
melewati prosesnya terlebih dahulu. Salah satu proses yang harus
ditempuh untuk mendapatkan hasil belajar siswa yaitu dengan memilih
metode belajar yang sesuai dengan materi serta karakteristik siswa.
Dalam penelitian ini, metode bernyanyi sangat membantu guru dalam
proses pembelajaran. Dengan adanya metode bernyanyi mampu
meningkatkan kemampuan siswa baik dalam ranah kognitif, afektif dan
psikomotorik dalam mata pelajaran PAI. Kemampuan siswa dalam
ranah kognitif dapat dilihat dari aspek intelektual meliputi pengetahuan
dan kemampuan berpikir siswa dalam mata pelajaran PAI. Kemampuan
siswa dalam ranah afektif dapat dilihat dari aspek moral ditunjukkan
melalui perasaan, nilai, motivasi, dan sikap peserta didik. Sedangkan
kemampuan siswa dalam ranah psikomotorik dapat dilihat melalui
aspek keterampilan peserta didik, yang merupakan implementasi dari
kegiatan belajar mengajar(Magdalena et al., 2020).

Untuk mencapai keberhasilan dalam proses pembelajaran dapat

dilihat manakala siswa mampu meningkatkan kemampuan berpikir

seperti ketika siswa mempelajari materi beriman kepada rasul Allah,
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maka siswa dapat meyakini keberadaan rasul Allah. Dalam ranah
afektif contohnya yaitu setelah meyakini keberadaan rasul Allah tentu
siswa akan meneladani sikap dan perilaku baik yang rasul ajarkan
kepada umatnya. Kemudian dalam ranah psikomotorik adalah siswa
mampu menerapkan sikap dan perilaku rosul Allah tersebut dalam
kehidupan sehari-hari.

Pada saat ketiga ranah tersebut dapat tercapai semuanya maka
proses pembelajaran akan mencapai hasil belajar yang maksimal dan
tujuan pembelajaran pun dapat terlaksana. Dengan demikian ketiga
ranah tersebut memiliki kaitan yang erat dalam mencapai keberhasilan
belajar.

5. Eksperiment dan Kontrol
a. Langkah-langkah Pembelajaran pada Kelas Eksperiment
Pendahuluan
1) Mempersiapkan beberapa media atau alat peraga yang akan
digunakan dalam proses pembelajaran
2) Mengucapkan salam, membaca doa, mengabsen siswa, menyapa
siswa dan menyampaikan tujuan pembelajaran

3) Guru mengkondisikan kelas dalam suasana kondusif untuk
berlangsungnya pembelajaran

4) Melakukan apersepsi materi sebelumnya

Kegiatan Inti
1) Mengamati

e Siswa mengamati materi yang akan dipelajari.

e Guru mencoba menyanyikan syair atau lagu yang sebelumnya
sudah disiapkan dan disesuaikan dengan materi yang akan
disampaikan

e Siswa mengamati syair tersebut kemudian siswa ikut
menyanyikan syair tersebut secara bersama-sama

2) Menanya
e Guru mengajukan pertanyaan kepada siswa terkait materi yang

terdpat dalam syair lagu.
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e Siswa bertanya mengenai materi yang telah disampaikan
melalui syair lagu.
3) Mengeksplorasi
e Guru membagi siswa ke dalam beberapa kelompok
e Setiap kelompok dipersilahkan mencari penjelasan tentang
materi yang tekait dari sumber belajar yang disediakan atau
dari sumber lain
e Setiap kelompok mendeskripsikan pendapatnya ke dalam buku
tulis
4) Mengasosiasikan
e Setiap kelompok siswa saling mendiskusikan hasil pencarian
tentang materi tersebut
e Guru dan siswa menyanyikan kembali lagu atau syair tentang
materi tersebut
5) Mengkomunikasikan
e Perwakilan dari masing-masing kelompok membacakan hasil
diskusi yang telah di diskusikan
e Kelompok lain menanggapi hasil diskusi kelompok lainnya
yang dipandu oleh guru
e Guru bersama siswa melakukan evaluasi materi presentasi
setiap kelompok
Penutup
1) Menyimpulkan hasil pembelajaran hari ini
2) Memberikan umpan balik positif dan penguatan terhadap partisipasi
siswa dalam mengikuti pembelajaran
3) Menutup kegiatan pembelajaran dengan doa bersama
b. Langkah-langkah Pembelajaran pada Kelas Kontrol
Pendahuluan
1) Mempersiapkan beberapa media atau alat peraga yang akan
digunakan dalam proses pembelajaran
2) Mengucapkan salam, membaca doa, mengabsen siswa, menyapa

siswa dan menyampaikan tujuan pembelajaran
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3) Guru mengkondisikan kelas dalam suasana kondusif untuk
berlangsungnya pembelajaran
4) Melakukan apersepsi materi sebelumnya
Kegiatan Inti
1) Mengamati
e Siswa mengamati gambar- gambar yang berkaitan dengan
materi yang akan disampaikan
2) Menanya
e Guru mengajukan pertanyaan kepada siswa mengenai
gambar
e Peserta didik melakukan tanya jawab mengenai gambar
3) Mengeksplorasi
e Guru membagi siswa ke dalam beberapa kelompok
e Setiap kelompok dipersilahkan mencari penjelasan tentang
materi tersebut dari sumber belajar yang disediakan atau
dari sumber lain
e Setiap kelompok mendeskripsikan pendapatnya ke dalam
buku tulis
4) Mengasosialisasikan
e Setiap kelompok siswa saling mendiskusikan hasil
pencarian tentang materi tersebut
5) Mengkomunikasikan
e Perwakilan dari masing-masing kelompok membacakan
hasil diskusi yang telah di diskusikan
e Kelompok lain menanggapi hasil diskusi kelompok lainnya
yang dipandu oleh guru
e Guru bersama siswa melakukan evaluasi materi presentasi
setiap kelompok
Penutup
1) Menyimpulkan hasil pembelajaran hari ini
2) Memberikan umpan balik positif dan penguatan terhadap

partisipasi siswa dalam mengikuti pembelajaran
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3) Menutup kegiatan pembelajaran dengan doa bersama
B. Kerangka Berfikir dan Skema Penelitian

Kurangnya penggunaan metode dalam proses pembelajaran dapat
mempengaruhi pengetahuan siswa dalam memahami materi sehingga
mendapatkan hasil belajar yang tidak sesuai.

Muhammad Fadillah mengemukakan bahwa metode bernyanyi
merupakan metode pembelajaran yang menggunakan syair-syair yang
dilagukan. Biasanya syair-syair tersebut disesuaikan dengan materi-materi
yang akan diajarkan oleh pendidik. Penggunaan metode bernyanyi dapat
menumbuhkan minat dan menguatkan daya tarik pembelajaran serta dapat
memberikan stimulus yang cukup kuat terhadap pengetahuan siswa
sehingga mendorong perkembangan kognitif peserta didik dengan cepat.

Hasil belajar menurut Nana Sudjana ialah kemampuan yang dimiliki
siswa setelah ia mendapatkan pengalaman belajarnya. Kemampuan
tersebut mencakup bidang kognitif, bidang afektif dan bidang
psikomotorik. Hasil belajar siswa pada proses pembelajaran merupakan
penentuan akhir sejauh mana siswa dapat memahami materi yang
disampaikan guru.

Dewasa ini, penggunaan metode dalam proses belajar masih kurang
pengaplikasiannya sehingga pembelajaran berjalan secara monoton dan
hal tersebut menjadi salah satu penyebab kurangnya hasil belajar siswa.

Idealnya metode pembelajaran di sekolah dapat digunakan oleh
pendidik guna memudahkan peserta didik dalam memahami materi yang
disampaikan sehingga proses pembelajaran berjalan sesuai tujuan
pembelajaran dan dapat mencapai hasil yang memuaskan.

Dengan demikian, adanya penggunaan metode bernyanyi dalam proses
pembelajaran dapat memudahkan siswa dalam memahami materi yang
disampaikan sehingga siswa dapat mencapai hasil belajar yang maksimal.

Adapun variabel dalam penelitian ini, peneliti gambarkan dengan

bentuk skema sebagai berikut:
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Gambar 2.1

“Pengaruh Penggunaan Metode Bernyanyi dalam Meningkatkan

Hasil Belajar PAI Siswa”

Metode Bernyanyi Hasil Belajar Siswa
—_—
Variabel (X) Variabel (Y)
Indikator- Indikator:

1 Menumbuhkan minat 1. Kognitif : meningkatkan

i pemahaman
2 Menguat_kan daya tarik 2. Afektif : perubahan tingkah
pembelajaran laku
3. {\/Iehm(ljaerlkan st![mhulus 3. Psikomotorik : mampu
erhadap pengetanuian mempraktikkan
siswa

Menurut Nana Sudjana
Menurut Muhammad Fadlillah J

Siswa

Keterangan:
Variabel X  : Yakni variabel yang mempengaruhi, yaitu metode

bernyanyi
Variabel Y  : Yaitu variabel yang dipengaruhi, ialah hasil belajar

siswa
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C. Hasil Penelitian yang Relevan

1. Vera Triatnasari, dari IAIN Raden Intan Lampung, tahun 2017 dengan

judul “Penggunaan Metode Bernyanyi Dalam Meningkatkan Hasil
Belajar Siswa Pada Pelajaran Matematika Kelas 111 B Min 11 Bandar
Lampung”. Hasil dari penelitiaannya yaitu Pada siklus | siswa yang
mencapai ketuntasan 14 dengan persentase 58,3%, sedangkan siswa
yang nilainya belum mencapai ketuntasan sebanyak 10 siswa dengan
persentase 41,7 %. Pada siklus 11 dilihat dari rata-rata tes siswa adalah
siswa yang mencapai ketuntasan 21 siswa dengan persentase 87,5%,
sedangkan siswa yang hasil belajarnya belum tuntas sebanyak 3 orang
dengan persentase 12,5%. Dengan demikian dapat disimpulkan bahwa
penerapan  pembelajaran dengan metode bernyanyi dapat
meningkatkan hasil belajar Matematika pada siswa kelas 111B MIN 11
Bandar Lampung.
Berdasarkan penelitian tersebut, peneliti mengemukakan adanya
perbedaan dari aspek metode yang digunakan yaitu penelitian diatas
menggunakan metode penelitian tindakan kelas. Sedangkan metode
yang digunakan peneliti dalam penelitian ini ialah metode eksperimen
quasi. Serta dalam mata pelajarannya pun berbeda.

2. Ferdinni haryanti, dari UIN Syarif Hidayatullah Jakarta, tahun 2020
dengan judul “Pengaruh Metode Bernyanyi Terhadap Hasil Belajar
Peserta Didik Kelas Il A Pada Pembelajaran Matematika (Perkalian)
Di MI Al-Mursyidiyya”. Hasil dari penelitiannya yaitu dinyatakan
bahwa diperoleh hasil nilai t hitung 9,858 > t tabel 2,034 atau HO
ditolak dan H1 diterima. Artinya, terdapat pengaruh metode bernyanyi
terhadap hasil belajar peserta didik kelas 11l A pada pembelajaran
matematika (Perkalian) di MI Al-Mursyidiyyah.

Pada penelitian yang telah dilakukan diatas, terdapat perbedaan hasil
pada penelitian yang dilakukan oleh peneliti. Perbedaannya terdapat
pada aspek teori yang digunakan ialah penelitian diatas menggunakan
teori Mohammad Fauziddin untuk metode bernyanyi sedangkan teori

Mudjiyono Dimyati untuk hasil belajar. peneliti menggunakan metode
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Muhammad Fadlillah untuk metode bernyanyi dan teori Nana Sudjana
untuk teori hasil belajar. Kemudian aspek metode yang digunakan
yakni penelitian diatas menggunakan metode pra eksperimen
sedangkan peneliti menggunakan metode eksperimen quasi. Serta mata
pelajaran yang diteliti juga berbeda.

Munira, dari UIN Aluddin Makasar, tahun 2021 dengan judul
“Pengaruh Metode Bernyanyi Terhadap Kemampuan Mengingat
Peserta Didik Pada Pembelajaran Pendidikan Agama Islam (PAI) Di
SDN Tanetea Kabupaten Gowa”. Hasil dari penelitiannya menyatakan
bahwa metode bernyanyi positif berpengaruh dalam meningkatkan
kemampuan mengingat peserta didik di kelas 2 SDN Tanetea
Kabupaten Gowa, hal ini dapat dilihat dari hasil hipotesis
membandingkan suatu ttabel dengan thitung.. Jika thitung > ttabel
(thitung 17,852> ttabel sebesar 2,052 ) maka Ho ditolak dan Ha
diterima. Jadi sesuai dengan hasil yang diperoleh dapat disimpulkan
bahwa Ha diterima, artinya penggunaan metode bernyanyi terhadap
kemampuan mengingat peserta didik efektif meningkatkan hasil
belajar peserta didik di SDN Tanetea Kabupaten Gowa.

Pada penelitian yang telah dilakukan diatas, terdapat perbedaan hasil
pada penelitian yang dilakukan oleh peneliti. Perbedaannya terdapat
pada aspek tujuan penelitian serta aspek metode yang digunakan
peneliti diatas ialah metode pra eksperimen sedangkan peneliti

menggunakan metode eksperimen quasi.

D. Hipotesis Penelitian

Berdasarkan kerangka berpikir di atas, maka dapat dirumuskan suatu

hipotesis dalam penelitian ini yaitu sebagai berikut:

Ha

Ho

: Terdapat pengaruh yang signifikan antara metode bernyanyi
terhadap hasil belajar PAI siswa
: Tidak terdapat pengaruh yang signifikan antara metode bernyanyi

terhadap hasil belajar PAI siswa
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BAB 111
METODOLOGI PENELITIAN
A. Pendekatan dan Metode Penelitian

Dalam melaksanakan penelitin ini, metode yang peneliti gunakan
yakni metode kuantitatif dengan pendekatannya yaitu pendekatan quasi
eksperimen. Quasi eksperimen / semu dapat diartikan sebagai salah satu
metode penelitian yang digunakan peneliti untuk mencari pengaruh
perlakuan tertentu terhadap yang lain dalam suatu kondisi yang terkendali
(Sugiyono, 2013). Alasan peneliti menggunakan metode tersebut yaitu
berawal dari permasalahan yang peneliti temukan di sekolah ini serta

menguji hipotesis sebab dan akibat pada setiap variabel.

Adapun penelitian ini dilakukan dengan menggunakan bentuk
Nonequivalent Control Group Design. Hal ini dikarenakan untuk
mengetahui pengaruh penggunaan metode bernyanyi terhadap hasil belajar
siswa PAI pada kelompok siswa eksperimen dibutuhkan kelompok siswa
kontrol yang dijadikan sebagai pembanding. Desain ini dapat digambarkan

sebagai berikut.

Tabel 3.1 Pola Desain Nonequivalent Control Group Design

Kelompok Siswa Pre-test Perlakuan Post-test
Eksperimen 01 X 02
Kontrol O3 - O4
Keterangan :
O:: Pre-test
O3 : Pre-test

X : Perlakuan Metode Pembelajaran
O; : Post-test

Qg4 : Post-test
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B. Tempat dan Waktu Penelitian

26

Tempat pelaksanaan penelitian ini adalah di SDN Karanganyar 1

tepatnya di desa Karanganyar kecamatan Klari kabupaten Karawang.

Alasan peneliti memilih tempat penelitian ini karena peneliti berasal dari

daerah tersebut dan cukup mengetahui kondisi perkembangan pendidikan

di sekolah tersebut.

Adapun waktu dilaksanakannya penelitian tahap awal yaitu pada

tanggal 05 April 2022. Rencana penelitian ini akan dilakukan sampai akhir

bulan Mei 2023.

C. Populasi dan Sampel

Populasi adalah sekumpulan unit yang diambil peneliti untuk diteliti

(Abdullah, 2015). Populasi dalam penelitian ini adalah siswa SDN

Karanganyar 1 kelas V sejumlah 42 siswa, dimana populasi tersebut

sekaligus dijadikan sampling dalam penelitian ini. Hal ini sesuai dengan

pendapat Arikunto yang menyatakan bahwa apabila subjek yang

digunakan kurang dari 100, maka seluruh populasi menjadi sampel

penelitian.

Adapun untuk menentukan kelas eksperimen dan kelas kontrol yaitu

dilakukan secara acak/ random.

Tabel 3.2 Jumlah Sampel

Siswa kelas V

Kelas Eksperimen

Kelas Kontrol

Jumlah Total

21

21

42

D. Jenis dan Sumber Data

Jenis data yang digunakan peneliti

yakni

menggunakan data

kuantitatif. Kuantitatif adalah suatu penelitian yang dilakukan peneliti

dengan mengumpulkan data yang berupa angka (Abdullah, 2015).
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Adapun sumber data yang digunakan peneliti dalam penelitian ini ialah
data primer dan data sekunder.
a. Data Primer
Data primer yakni data yang langsung didapatkan dari sumber utama
(Nugrahani, 2014). Adapun data primer dalam penelitian ini ialah
guru PAI SDN Karanganyar 1 yang berjumlah satu orang bernama
Rina Merzalena.
b. Data Sekunder
Data sekunder yakni berupa sumber data tambahan yang dihasilkan
dari sumber yang bukan asli (Nugrahani, 2014). Data sekunder yang

digunakan peneliti dalam penelitian ini adalah berupa buku dan jurnal.
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E. Teknik Pengumpulan Data

Adapun teknik pengumpulan data yang dilakukan peneliti ialah melalui

prosees wawancara, observasi, angket, tes dan dokumentasi. Berikut

pengertian teknik pengumpulan data yang peneliti gunakan:

a. Observasi
Magono dalam (Rahmadi, 2011) berpendapat mengenai observasi
ialah pengamatan atau pencatatan secara sistematis terhadap gejala
yang ada pada objek penelitian. Adapun peneliti melakukan observasi
dalam penelitian ini dengan cara mengamati langsung ke sekolah
untuk mendapatkan data tentang profil sekolah, sejarah berdirinya
sekolah, sarana dan prasarana yang tersedia di sekolah dan proses
pembelajaran di SDN Karanganyar 1 Karawang.

b. Angket
Angket merupakan suatu daftar pernyataan atau pertanyaan tertulis
untuk mendapatkan informasi (Syahrum & Salim, 2012). Adapun
angket dalam peneitian ini berupa beberapa pernyataan yang akan
diberikan kepada siswa untuk dijawab sesuai pendapat masing-
masing kelas V di SDN Karanganyar 1 Karawang. Angket yang
disusun oleh peneliti berupa pernyataan mengenai metode bernyanyi
dengan indikator memahami materi yang disampaikan sehingga
mendapat hasil belajar yang maksimal. Instrumen yang peneliti
gunakan untuk mengukur variabel penelitian ini menggunakan skala
likert (Sugiyono, 2013). Skala likert mempunyai gradasi dari sangat
positif sampai sangat negatif.

Tabel 3.3 Penskoran Angket

Alternatif Jawaban Skor
Sangat setuju 4
Setuju 3
Tidak setuju 2
Sangat tidak setuju 1
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c. Tes
Tes yaitu proses pengmpulan data dengan cara mengajukan beberapa
pertanyaan kepada sumber data dengan maksud untuk mengujinya
(Mundir, 2013).
Tes yang peneliti lakukan yaitu memberikan beberapa pertanyaan pre
test dan post test kepada siswa kelas V SDN | Karanganyar berjumlah
20 butir soal yang dikembangkan dari hasil teori kisi-kisi pernyataan
dari materi beriman kepada Rasul Allah bertujuan untuk mengetahui
pengaruh penggunaan metode bernyanyi terhadap hasil belajar siswa
di sekolah tersebut.

d. Dokumentasi
Dokumentasi ialah teknik pengumpulan data penelitian dengan
mengumpulkan sejumlah data atau dokumen berupa dokumen tertulis
maupun dokumen terekam (Rahmadi, 2011). Dokumentasi digunakan
peneliti untuk mengumpulkan berbagai data yang berhubungan
dengan metode pembelajaran serta hasil belajar siswa di SDN
Karanganyar 1 Karawang melalui guru mata pelajaran PAL.

F. Definisi Operasional

a. Metode Bernyanyi
Metode bernyanyi merupakan salah satu metode pembelajaran yang
digunakan guru pada proses belajar mengajar dengan menyanyikan
syair- syair yang sebelumnya sudah diolah agar sesuai dengan materi
yang akan disampaikan oleh guru. Metode bernyanyi yang digunakan
guru dapat memudahkan siswa dalam memahami materi yang
disampaikan oleh guru. Selain itu, dengan menggunakan metode
bernyanyi dapat membuat proses pembelajaran lebih aktif,
menyenangkan dan menambah semangat siswa dalam proses
pembelajaran.

b. Hasil Belajar
Hasil belajar adalah suatu kemampuan yang yang diperoleh oleh
peserta didik setelah ia menerima rangkaian proses pembelajaran.

yang dimaksud dengan hasil belajar disini adalah keberhasilan peserta
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didik dalam memahami materi yang telah dipelajari. Hal tersebut
sejalan dengan pendapat (Sudjana, 2009b) yang menyatakan bahwa
hasil belajar adalah keberhasilan kemampuan yang dimiliki peserta
didik setelah menerima pengalaman belajar. Pengalaman belajar
tersebut didapatkan dari kegiatan belajar yang dilakukan peserta didik.
Hasil belajar dapat diperoleh dan dilihat melalui kegiatan evaluasi.
Yang mana kegiatan evaluasi ini bertujuan untuk mengetahui tingkat
kemampuan siswa dalam mencapai tujuan pembelajaran. Kegiatan
evaluasi ini biasanya dilakukan setelah kegiatan belajar selesai.
G. Instrumen Penelitian
Dalam penelitian ini, instrumen memiliki peranan yang sangat
penting, karena instrumen menjadi alat ukur yang akan memberikan
informasi mengenai sesuatu yang Kkita teliti. Instrumen dalam penelitian ini
bertujuan untuk mengukur tingkat pengaruh penggunaan metode variabel
X yaitu metode bernyanyi terhadap variabel Y yaitu hasil belajar.
1. Kisi-kisi
Angket merupakan cara yang digunakan peneliti dalam
pengumpulan data ini. Angket digunakan untuk mengetahui sejauh
mana siswa dapat memahami dan mengerti materi yang diajarkan
sehingga dapat mengimplementasikan dalam kehidupan sehari-hari
dan memperoleh hasil belajar yang maksimal. Angket yang disusun
peneliti berupa beberapa pernyataan yang sudah dirumuskan sesuai
dengan pedoman. Adapun Kisi-kisi instrumen angket tersebut
terlampir.
Selain menggunakan angket, peneliti juga menggunakan tes pada
penelitian ini. Dalam penelitian ini, tes yang dilakukan dibagi menjadi
2 yaitu pre-test (tes sebelum pembelajaran) dan post-test (tes setelah
pembelajaran) dengan pernyataan yang sama. Hal tersebut dilakukan
untuk mengetahui perbedaan dan peningkatan hasil belajar siswa yang
terjadi sebelum dan sesudah diterapkannya metode bernyanyi dalam

pembelajaran Pendidikan Agama Islam kelas V di SD Karanganyar 1.
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Jenis tes yang dipakai dalam penelitian ini adalah berupa angket
yang di dalamnya terdapat beberapa pernyataan. Yang mana angket
tersebut digunakan untuk pre-test dan post-test. Sebelum pernyataan
ini disusun, peneliti terlebih dahulu menyusun Kkisi-Kisi sebagai
pedoman dalam merumuskan pertanyaan yang akan dituangkan dalam
bentuk soal. Adapun Kisi-Kisi instrumen soal tes tersebut terlampir.

2. Instrumen

a. Lembar Angket

Instrumen ini berupa angket yang tersusun dari beberapa
pernyataan terdiri dari 34 pernyataan. Angket ini di dalamnya
memuat penggunaan metode bernyanyi pada mata pelajaran
Pendidikan Agama Islam kelas V dengan tema ‘“Beriman
Kepada Rasul-Rasul Allah SWT”. Instrumen ini digunakan
untuk mengetahui hasil belajar siswa sebelum dan sesudah
digunakannya metode bernyanyi pada mata pelajaran PAL.

Tes awal (pre-test) digunakan untuk mengetahui hasil
belajar peserta didik sebelum diberi perlakuan. Sedangkan test
akhir (post-test) digunakan untuk mengetahui hasil belajar
peserta didik setelah pembelajaran selesai dilakukan. Hasil dari
instrumen tes ini tidak lain untuk mengetahui. Adapun bentuk
instrumen pernyataan dapat dilihat pada bagian lampiran

b. Dokumentasi

Dokumentasi ini digunakan peneliti dalam mengumpulkan
data tertulis yang relevan dengan penelitian. Data tersebut
dapat berupa profil sekolah, data pendidik dan tenaga
kependidikan, data siswa, dan data-data lainnya yang
dibutuhkan dalam penelitian.

3. Uji Instrumen (Validitas dan Reliabilitas)
Untuk mendapatkan hasil evaluasi yang baik, maka sebelum
angket digunakan terlebih dahulu diuji cobakan dengan tujuan

untuk menguji validitas dan reliabilitas dari angket yang
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digunakan. Adapun langkah-langkah uji instrumen ialah sebagai
berikut:
a. UjiValiditas
Untuk menguji validitas kontruksi, dapat digunakan
pendapat para ahli (judgment expert). Dalam hal ini setelah
instrumen di kontruksikan tentang aspek-aspek yang akan
diukur dengan berlandaskan teori tertentu, maka selanjutnya
dikonsultasikan dengan para ahli. Para ahli diminta
pendapatnya tentang instrumen yang telah disusun. Sedangkan
untuk menentukan setiap butir pernyataan disebut valid atau
tidak, uji ini dilakukan dengan cara membandingkan angka r
hitung dan r tabel. Jika r hitung lebih besar dari r tabel maka
item dikatakan valid dan sebaliknya jika r hitung lebih kecil
dari r tabel maka item dikatakan tidak valid. Berikut adalah
langkah-langkah uji validitas :
1) Menghubungi dosen/ahli terkait variabel yang akan diteliti.
2) Menguji unsur keabsahan.
3) Menguji kesesuaian kalimat yang digunakan dengan
indikator
Uji validitas dengan alat hitung komputer (SPSS) sebagai
berikut :
1) Membuka aplikasi SPSS.
2) Aktifkan variabel view => klik data view.
3) Input data hasil uji instrument kedalam lembar kerja SPSS.
4) Klik menu anlyze => correlate => bivariate.
5) Pindahkan semua item 1 sampai pelayanan ke kotak yang
ada di sebelah kanan, lalu centang pearson, two tailed dan

flog significantcorrelation kemudian klik OK.

Dalam menggunakan analisis software SPSS, butir soal
instrumen dikatakan valid jika Corrented Item-Total Correlation

lebih besar dari r tabel.
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b. Uji Reliabilitas

Suatu instrumen penelitian dikatakan reliabel jika
instrumen tersebut dapat menghasilkan data penelitian yang
konsisten, karena dengan konsistenlah sebuah data dapat
dipercaya kebenarannya. Adapun langkah-langkah uji
reliabilitas instrumen dengan menggunakan software adalah
sebagai berikut:

1) Buka program SPSS.

2) Aktifkan Variabel View => klik Data View.

3) Input data hasil uji instrumen kedalam lembar kerja

SPSS.
4) Klik menu Anlyze => Scale => Reliability Analysis
5) Pindahkan semua item kecuali item total.

6) Klik statistic dan beri centang pada bagian Scale If Item
Deleted kemudian klik OK

Instrumen dikatakan reliabel apabila reliability lebih besar

dari pada r tabel.

H. Teknik Analisis Data
Setelah mengumpulkan data yang dibutuhkan, maka peneliti
melakukan kegiatan analisis data. Analisis data ialah kegiatan
mengelompokkan data berdasarkan variabel dan jenis responden,
mentabulasi data berdasarkan variabel dari seluruh responden, menyajikan
dta tiap variabel yang diteliti, melakukan perhitungan untuk menguji
hipotesis yang telah diajukan (Sugiyono, 2013).
1. Deskripsi Data Tiap Kelas (kelas kontrol dan kelas eksperimen)
a. Prosentase
Prosentase mendeskripsikan perolehan skor data secara
skala prosentase. Cara penghitungannya adalah sebagai

berikut: perolehan skor X 100

Skor maksimal
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b. Ukuran Pemusatan (modus, mean, median)

1)

2)

3)

Modus adalah nilai yang memiliki frekuensi tinggi atau nilai
yang sering muncul.
Mean ialah nilai rata-rata dari nilai yang diperoleh dari
masing-masing individu yang kemudian dikelompokkan dan
diambil nilai rata-rata dari kelompok tersebut. Mean
didapatkan dengan cara menjumlahkan data dari seluruh
individu kemudian dibagi jumlah individu yang ada dalam
kelompok tersebut.

Median ialah nilai yang terletak di tengah pada data yang telah

diurutkan dari nilai terkecil sampai terbesar. Jika banyak data

ganjil, maka nilai median terletak di tengah setelah diurutkan.

Namun jika banyak data genap, maka nilai median tersebut

adalah rata-rata dari dua data yang terletak di tengah setelah

diurutkan.

Adapun langkah-langkah untuk menghitung Mean, Median,

Modus dengan menggunakan software SPSS adalah sebagai

berikut :

1) Buka program SPSS

2) Masukkan data yang akan dianalisis.

3) Klik Analyze > Descriptive Statistics > Frequencies,
sehingga muncul kotak dialog Frequencies.

4) Masukkan nama variabel yang di analisis ke dalam kotak
variabel (s).

5) Kilik tombol statistics sehingga akan muncul kotak dialog
Frequencies:Statistics.

6) Klik dan pilih nilai pada Percentiles Values, Central
Tendency, Dispersion dan Distribution. Pilih sesuai
keperluan analisis deskriptif yang dibutuhkan (Mean,
Median dan Modus).

7) Klik tombol continue.
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Ukuran Penyebaran (range, variansi, standar deviasi)

Ukuran Penyebaran Data adalah suatu ukuran yang menyatakan

seberapa besar nilai-nilai data berbeda atau bervariasi dengan

ukuran pusatnya atau seberapa besar penyimpangan nilai-niai data

dengan pusatnya. Ukuran penyebaran data yang digunakan dalam

penelitian, yaitu :

1)

2)

Range, yaitu rentang atau jangkauan atau selisih antara skor

yang tertinggi dengan skor terendah dalam kumpulan atau

kelompok data. Adapun penghitungannya menggunakan
aplikasi SPSS sebagai berikut:

a) Buka program SPSS.

b) Masukkan data yang akan dianalisis.

c) Klik Analyze > Descriptive Statistics > Frequencies,
kemudian akan muncul kotak dialog Frequencies.

d) Masukkan nama variabel yang di analisis ke dalam kotak
variabel(s).

e) Klik tombol statistics setelah itu akan muncul kotak dialog
Frequencies:Statistics.

f) Klik dan pilih nilai pada Percentiles Values, Central
Tendency, Dispersion dan Distribution. Pilih sesuai
keperluan analisis deskriptif yang dibutuhkan / range

Variansi ialah simpangan dari semua nilai data terhadap rata-

rata hitung. Adapun penghitungannya menggunakan SPSS

sebagai berikut:

a) Buka program SPSS.

b) Masukkan data yang akan dianalisis.

c) Klik Analyze > Descriptive Statistics > Frequencies, akan
muncul kotak dialog Frequencies.

d) Masukkan nama variabel yang di analisis ke dalam kotak

variabel(s).
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e) Kilik tombol statistics kemudian akan muncul kotak dialog
Frequencies:Statistics.

f) Klik dan pilih nilai pada Percentiles Values, Central
Tendency, Dispersion dan Distribution sesuai keperluan
analisis deskriptif yang dibutuhkan / variansi.

g) KIlik tombol continue.

3) Standar Deviasi merupakan simpangan baku yang merupakan
akar pangkat dua dari variasi. Adapun penghitungannya
menggunakan SPSS sebagai berikut :

a) Buka program SPSS

b) Masukkan data yang akan dianalisis.

c) Kilik Analyze > Descriptive Statistics > Frequencies, akan
muncul kotak dialog Frequencies.

d) Masukkan nama variabel yang di analisis ke dalam kotak
variabel(s).

e) Kilik tombol statistics kemudian akan muncul kotak dialog
Frequencies:Statistics.

f) Klik dan pilih nilai pada Percentiles Values, Central
Tendency, Dispersion dan Distribution sesuai keperluan
analisis deskriptif yang dibutuhkan / std deviasi.

g) Kilik tombol continue

d. Display Data (Tabel/ Histogram)

Penyajian data yang digunakan untuk mendeskripsikan
analisis statistik deskriptif dalam penelitian ini yaitu dengan
menggunakan  histogram. Histogram yaitu grafik yang
menggambarkan data dengan menempatkan sederetan batang
(bars) pada gambar dengan pengertian bahwa tinggi masing-
masing itu menunjukkan frekuensinya. Untuk menganalisa
statistik deskritif apabila menggunakan bantuan software SPSS,
maka langkah-langkahnya adalah sebagai berikut:

1) Buka program SPSS.

2) Masukkan data yang akan dianalisis.
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3) Klik Analyze > Descriptive Statistics > Frequencies,
kemudian muncul kotak dialog Frequencies.

4) Masukkan nama variabel yang di analisis ke dalam kotak
variabel(s).

5) Klik tombol statistics kemudian akan muncul kotak dialog
Frequencies:Statistics.

6) KIlik dan pilih nilai pada Percentiles Values, Central Tendency,
Dispersion dan Distribution sesuai keperluan analisis
deskriptif yang dibutuhkan.

7) KIik continue

8) Kilik Charts, kemudian akan muncul kotak dialog Frequencies
Chart, lalu pilih Histogram With Normal Curve pada kotak
Chat Type.

9) KIlik continue lalu Klik OK.

2. Uji Prasyarat Analisis tiap Variabel
a. Uji Normalitas
Uji normalitas data dimaksudkan untuk memastikan bahwa
data sampel berasal dari populasi yang berdistribusi normal.
Data dapat dikatakan berdistribusi normal apabila nilai P (sig.) >
0,05. Uji normalitas dengan menggunakan bantuan software
SPSS, dilakukan dengan langkah-langkah sebagai berikut :
1) Buka program SPSS
2) Masukkan data yang akan dianalisis.
3) Klik Analyze >Descriptive Statistics >Explore
4) Setelah muncul kotak dialog Uji normalitas, selanjutnya pilih
Y atau X sebagai dependent List.
5) Klik kotak Normality Plot with Test.
6) klik continue, lalu OK.
b. Uji Homogenitas
Uji homogenitas dilakukan untuk memperlihatkan bahwa
kelompok data sampel berasal dari populasi yang mempunyai

variansi yang sama. Uji homogenitas dengan menggunakan
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bantuan software SPSS, dilakukan dengan langkah-langkah
sebagai berikut:
1) Buka program SPSS.
2) Masukkan data yang akan dianalisis.
3) Pilih menu Analyze => Descriptive Statistic => Explore
4) Pilih data hasil belajar ke Dependen List dan data kelas ke
Factor List.
5) Kklik Plots => Power Estimation.
6) Klik Continue lalu OK.
3. Uji Hipotesis
a. Analisis Sebelum dan Setelah Perlakuan
Untuk melakukan uji hipotesis terhadap hasil sebelum dan setelah
perlakuan, dilakukan analisis dengan menggunakan Independent
Sampel t-Test. Adapun langkah-langkah untuk menguji Paired
Sample t-test dengan bantuan software SPSS sebagai berikut :
1) Buka program SPSS.
2) Masukan data pada Variable.View >Data View.
3) Kilik Analyze >Compare Means >Independent Sample T Test.
4) Hasil belajar diletakkan di Test Variable dan Kelas
diletakkan di Grouping Variable > Klik Define Group >
masukan angka 1 di grup 1 dan angka 2 di grup 2
5) Klik option sehingga kotak dialog muncul. Secara default
pilih tingkat kepercayaan 95% dan Enclude Cases Analysis
By Analysis terpilih.
6) Klik Continue Lalu OK.
b. Analisis Peningkatan
Untuk melakukan uji hipotesis terhadap ada atau tidaknya
peningkatan hasil perlakuan, “dilakukan analisis dengan
menggunakan Paired Sample t-Test.”Adapun langkah-langkah
untuk menguji Paired Sample t-Test dengan bantuan software

SPSS sebagai berikut:
1) Buka program SPSS.
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2) Masukkan data dalam tabel analisis.

3) Klik Analyze > Compare Means > Paired Sample T-Test .

4) Masukkan data Pre-Tes Eksperimen pada kolom variable 1 dan
Post-Tes Eksperimen pada kolom variable 2 di pair 1. Pre-Tes
Kontrol pada kolom variable 1 dan Post-Tes pada kolom
variable 2 di pair 2.

5) Klik option sehingga kotak dialog akan muncul. Secara default
pilih tingkat kepercayaan 95% dan Enclude Cases analysis by
analysis terpilih.

6) Klik Continue lalu OK

c. Perubahan Hasil
Untuk menganalisa perubahan hasil (tingkat keberhasil belajar

siswa) dapat dilakukan dengan N-Gain Score dengan rumus :

N-Gain = Skor Post-Tes — Skor Pre-Test
Skor ldeal — Skor Pre-Test

Adapun langkah-langkah dengan bantuan SPSS adalah sebagai
berikut :
1) Buka program SPSS.
2) Masukan data dalam tabel analisis.
3) Menghitung Skor Post-Test — Skor Pre Test.
e Kilik Transform > Compute Variable
e Pada kolom Target Variable diisi dengan keterangan
(Post- _Kurang_Pre) dan pada Numeric Expression diisi
dengan data (Post-Test — Pre-Test).
e LaluOK.

4) Menghitung Skor Ideal — Skor Pre-Test.
® Kilik Transform > Compute Variable

® Pada kolom Target Variable diisi dengan keterangan
(Seratus- _Kurang_Pre) dan pada Numeric Expression
diisi dengan data (100 — Pre-Test).

e LaluOK.
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5) Menentukan N-Gain Score.
® Kilik Transform > Compute Variable

® Pada kolom Target Variable diisi dengan keterangan
(N_Gain_Score) dan pada Numeric Expression diisi
dengan data (Post_Kurang_Pre dibagi
Seratus_Kurang_Pre).

® laluOK

6) Menentukan N-Gain Persen
® Kilik Transform > Compute Variable

® Pada kolom Target Variable diisi dengan keterangan
(N_Gain_Persen) dan pada Numeric Expression diisi
dengan data (N-Gain_Score dikali 100).

® |[aluOK.

7) Klik Analyze > Descriptive Statistic > Explore.
8) Masukan data N-Gain Persen pada kolom Dependent List dan

data kelas pada kolom Factor List.

9) LaluOK
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BAB IV
HASIL PENELITIAN DAN PEMBAHASAN

A. Deskripsi Tempat Penelitian

1.

Identitas Sekolah

Peneliti melakukan penelitian di sekolah dasar (SD) Negeri
Karanganyar 1 yang berstatus Negeri dengan NPSN : 20236289. Status
kepemilikannya merupakan milik pemerintah daerah dengan SK
pendirian sekolah : 421.2/sk163/1981, Tanggal SK Pendirian : 1981-
01-01, SK Izin Operasional : 421.2/Kep.422-Huk/2010, Tanggal SK
Izin Operasional :2010-06-01. Sekolah tersebut beralamatkan di
Dusun Karanganyar, RT 012 RW 003, Desa / Kelurahan Karanganyar,
Kecamatan Klari, Kabupaten Karawang, Provinsi Jawa Barat, Kode
Pos : 41371. Sekolah ini juga berakreditasi B, sedangkan kurikulum
yang digunakan adalah kurikulum 2012 dengan kepala sekolahnya
adalah ibu lis Rahmawati dan operator data akademik adalah bapak
Dhany Rahayu. Sedangkan untuk waktu kegiatan belajar mengajar di
SDN Karanganyar 1 adalah pada pagi hari.

Data Pendidik dan Tenaga Kependidikan

Jumlah guru di SDN Karangayar 1 berjumlah 3 orang laki-laki dan 5
orang perempuan, jadi totalnya adalah 8 orang guru. Tenaga pendidik
di SDN Karangayar 1 berjumlah 2 orang laki-laki. Untuk PTK
berjumlah 5 orang laki-laki dan 5 orang perempuan, totalnya adalah 10
orang. Sedangkan peserta didik berjumlah 120 siswa laki-laki dan 150
siswa perempuan, total peserta didik SDN Karangayar 1 adalah 270
siswa.

Sarana dan Prasarana

Sarana dan prasarana yang tersedia di sekolah SDN Karangayar 1 ialah
ruang kelas berjumlah 6 kelas. Terdapat juga ruang perpustakaan 1,
ruang guru 1, toilet berjumlah 4, dan ruang bangunan 2, total sarana
yang tersedia di SDN Karangayar lberjumlah 14 dengan kondisi

sarana tersebut berkategori Baik.

41



42

B. Deskripsi Hasil Penelitian
1. Validitas Data dan Reliabilitas Data
a. Uji Validitas
Peneliti melakukan uji validitas instrumen yang telah dibuat
terlebih dahulu yaitu berupa angket yang berisi 34 butir pernyataan
dan instrumen tes yang berisi 20 soal berupa pilihan gada (PG)
yang akan digunakan dalam penelitian. Hal itu dilakukan untuk
dapat melihat valid atau tidaknya instrumen tersebut. Peneliti
melakukan uji validitas dengan dua cara yaitu uji validitas ahli dan
empiris.
Uji validitas ahli pada instrumen angket dilakukan melakukan
expert judgement oleh dosen revieuwer Kisi-kisi dan instrumen di
STAI DR. KHEZ. Muttagien Purwakarta. Dengan hasil yang
menyatakan bahwa instrumen angket tersebut layak digunakan
sebagai instrumen penelitian dengan sedikit perbaikan.
Adapun uji validitas ahli pada instrumen tes dilakukan oleh guru
mata pelajaran Pendidikan Agama Islam di SDN Karanganyar 1
yang menyatakan bahwa instrumen tes tersebut layak digunakan
dalam penelitian ini.
Uji validitas empiris dilakukan dengan menguji coba angket dan
soal tes tersebut kepada 35 siswa di kelas V SDN karanganyar 3.
Serelah data terkumpul, dilakukan pengujian untuk mengetahui
instrumen angket dan soal tes tersebut valid atau tidak dengan
menggunakan alat bantu software SPSS. Adapun hasil uji validitas
dengan menggunakan SPSS dengan ketentuan sebagai berikut :
1) Jika rhitung > rtabel, maka instrumen tersebut dinyatakan valid
dan dapat digunakan.
2) Jika rhitung < rtabel, maka instrumen tersebut dinyatakan tidak
valid dan tidak dapat digunakan
Jika melihat rhitung dengan jumlah sampel (N) = 35 dan taraf
signifikasi 5%, maka nilai rtabel df=n—-2 =>df =35-2 =33
adalah 0,333
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Hasil Uji Validitas Instrumen Angket Pengaruh Metode

Bernyanyi
Item Nilai r Tabel | Nilai r Hitung | Nilai Sig. | Keterangan
angket
1. 10,333 718 ,000 Valid
2. 10,333 867 ,000 Valid
3. 10,333 718 ,000 Valid
4. 10,333 ,643 ,000 Valid
5 10,333 ,867 ,000 Valid
6. |0,333 718 ,000 Valid
7. 10,333 ,965 ,000 Valid
8. 10,333 ,804 ,000 Valid
9. /0,333 ,965 ,000 Valid
10. {0,333 , 7115 ,000 Valid
11. {0,333 ,961 ,000 Valid
12. {0,333 128 ,000 Valid
13. {0,333 ,590 ,000 Valid
14. {0,333 ,641 ,000 Valid
15. {0,333 128 ,000 Valid
16. | 0,333 ,865 ,000 Valid
17. {0,333 ,641 ,000 Valid
18. [ 0,333 ,895 ,000 Valid
19. (0,333 ,718 ,000 Valid
20. | 0,333 ,893 ,000 Valid
21. | 0,333 (24 ,000 Valid
22. {0,333 ,893 ,000 Valid
23. 10,333 ,492 ,003 Valid
24. | 0,333 ,608 ,000 Valid
25. {0,333 ,492 ,003 Valid
26. | 0,333 ,385 ,022 Valid
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27. 10,333 437 ,009 Valid
28. 10,333 ,940 ,000 Valid
29. 10,333 ,385 ,022 Valid
30. [0,333 437 ,009 Valid
31. 10,333 ,854 ,000 Valid
32. 10,333 ,945 ,000 Valid
33. 10,333 ,854 ,000 Valid
34. |0,333 , 728 ,000 Valid

Berdasarkan tabel diatas dapat diketahui bahwa nilai rhitung yang

diperoleh lebih besar rtabel, maka 34 butir angket tersebut dinyatakan

valid untuk dijadikan instrumen penelitian.

Tabel 4.2
Hasil Uji Validitas Instrumen Soal Tes Hasil Belajar
No Soal | Nilai r Tabel | Nilai r Hitung | Nilai Sig. | Keterangan
1. 0,333 ,440 ,008 Valid
2. 0,333 418 ,012 Valid
3. 0,333 ,440 ,008 Valid
4, 0,333 ,356 ,036 Valid
5. 0,333 ,396 ,018 Valid
6. 0,333 497 ,002 Valid
7. 0,333 ,494 ,003 Valid
8. 0,333 ,550 ,001 Valid
9. 0,333 ,400 ,017 Valid
10. 0,333 ,440 ,008 Valid
11. 0,333 ,644 ,000 Valid
12. 0,333 ,588 ,000 Valid
13. 0,333 513 ,002 Valid
14, 0,333 ,385 ,024 Valid
15. 0,333 ,462 ,005 Valid
16. 0,333 527 ,001 Valid
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17. 0,333 ,403 ,016 Valid
18. 0,333 473 ,004 Valid
19. 0,333 418 ,012 Valid
20. 0,333 ,357 ,035 Valid

Berdasarkan tabel diatas dapat diketahui bahwa nilai rhitung yang
diperoleh lebih besar rtabel, maka 20 butir soal tersebut dinyatakan

valid untuk dijadikan instrumen penelitian.

. Uji Reliabilitas

Peneliti menguji instrumen angket dan tes dengan uji reliabilitas
untuk mengetahui reliable atau tidak nya instrumen tersebut. Dalam
penelitian ini, peneliti menggunakan metode alpha-cronbach
dengan bantuan software SPSS. Adapun hasil uji reliabilitas

instrumen tersebut sebagai berikut :

Tabel 4.3
Hasil Uji Reliabilitas Angket
Cronbach’s Alpha N of items
,624 34

Berdasarkan tabel di atas, dapat diketahui bahwa pada kolom
alpha-cronbach menunjukkan angka 0,624 yang berarti > 0,333

sehingga dapat disimpulkan bahwa butir angket tersebut reliable.

Tabel 4.4
Hasil Uji Reliabilitas Soal Tes
Cronbach’s Alpha N of items
0,823 20

Berdasarkan tabel di atas, dapat diketahui bahwa pada kolom
alpha-cronbach menunjukkan angka 0,823 yang berarti > 0,333

sehingga dapat disimpulkan bahwa butir soal tes tersebut reliable.
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2. Deskripsi Data Tiap Variabel
a. Deskripsi Data

Penelitian ini melibatkan kelas V yang dibagi menjadi dua
kelompok vyaitu kelas eksperimen yang menggunakan
pembelajaran menggunakan metode bernyanyi, dan kelas kontrol
yang pembelajarannya tidak menggunakan metode bernyanyi.
Kedua kelompok tersebut dipilih secara random.

Subjek penelitian tersebut dibagi menjadi 2 yang terdiri dari
21 peserta didik sebagai kelompok eksperimen, dan 21 peserta
didik sebagai kelompok kontrol. Kedua kelompok tersebut
diberikan pre-test dan post-test dalam bentuk angket untuk
mengetahui pemahaman siswa terhadap materi dari beragam aspek
dengan metode bernyanyi serta diberikan juga soal tes untuk
mengetahui perubahan hasil belajar PAI pada peserta didik.

b. Deskripsi Data Hasil Pre-Test Dan Post-Tes Angket Metode

Bernyanyi
1) Deskripsi Data Pre-Test Angket Kelas Eksperimen

Dari angket yang disebarkan maka diketahui hasil sebagai
berikut:

Tabel 4.5
Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan positif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 25 100
2 | Setuju 126 378
3 | Tidak Setuju 169 338
4 | Sangat Tidak Setuju 37 37

Jumlah 357 853
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Tabel 4.6
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Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan negatif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 24 24
2 | Setuju 172 344
3 | Tidak Setuju 139 417
4 | Sangat Tidak Setuju 22 88

Jumlah 357 873

2)

Data pada tabel di atas diambil dari hasil angket yang
disebarkan pada peserta didik menunjukkan bahwa skor rata-
rata tentang pengaruh metode bernyanyi dalam meningkatkan
pemahaman pembelajaran PAI pada kelas eksperimen sebelum
diberikan perlakuan metode bernyanyi adalah 1.726: 714 = 2,4
Dengan demikian dapat disimpulkan bahwa peserta didik kelas
V mengakui bahwa metode bernyanyi tidak berpengaruh pada

pemahaman pembelajaran PAL.

Deskripsi Data Post-Test Angket Kelas Eksperimen
Dari angket yang disebarkan pada kelas eksperimen maka
diketahui hasil post-test angket sebagai berikut:
Tabel 4.7
Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan positif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 188 752
2 | Setuju 150 450
3 | Tidak Setuju 19 38
4 | Sangat Tidak Setuju 0 0

Jumlah 357 1.240
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Tabel 4.8
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Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan negatif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 0 0
2 | Setuju 7 14
3 | Tidak Setuju 131 393
4 | Sangat Tidak Setuju 219 876
Jumlah 357 1.283

3) Deskripsi data pre-test angket kelas kontrol

Data pada tabel di atas diambil dari hasil angket yang

disebarkan pada peserta didik menunjukkan bahwa skor rata-

rata tentang pengaruh metode bernyanyi dalam meningkatkan

pemahaman pembelajaran PAI pada kelas eksperimen sebelum

diberikan perlakuan metode bernyanyi adalah 2.523: 714 = 3,5

dengan kategori sangat setuju.

Dengan demikian dapat

disimpulkan bahwa peserta didik kelas V mengakui bahwa

metode bernyanyi berpengaruh pada pemahaman pembelajaran

PAI.

Dari angket yang disebarkan maka diketahui hasil sebagai

berikut:

Tabel 4.9

Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan positif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 11 44
2 | Setuju 184 552
3 | Tidak Setuju 138 276
4 | Sangat Tidak Setuju 24 24

Jumlah 357 896
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Tabel 4.10
Pemahaman siswa dalam pembelajaran PAI dengan metode
bernyanyi (butir angket pernyataan negatif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 17 17
2 | Setuju 190 380
3 | Tidak Setuju 137 411
4 | Sangat Tidak Setuju 13 52

Jumlah 357 860

Data pada tabel di atas diambil dari hasil angket yang
disebarkan pada peserta didik menunjukkan bahwa skor rata-
rata tentang pengaruh metode bernyanyi dalam meningkatkan
pemahaman pembelajaran PAI sebelum test soal pada kelas
kontrol adalah 1756 : 714= 2,4 dengan kategori tidak setuju.
Dengan demikian dapat disimpulkan bahwa peserta didik kelas
V mengakui bahwa metode bernyanyi tidak berpengaruh pada

pemahaman kognitif.

4) Deskripsi data post-test angket kelas kontrol
Dari angket yang disebarkan maka diketahui hasil sebagai
berikut:
Tabel 4.11
Pemahaman siswa dalam pembelajaran PAI dengan metode

bernyanyi (butir angket pernyataan positif)

No Kategori Frekuensi Skor
1 | Sangat Setuju 25 100
2 | Setuju 146 438
3 | Tidak Setuju 165 330
4 | Sangat Tidak Setuju 21 21

Jumlah 357 889
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Tabel 4.12
Pemahaman siswa dalam pembelajaran PAI dengan metode
bernyanyi (butir angket pernyataan negatif)
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No Kategori Frekuensi Skor
1 | Sangat Setuju 14 14
2 | Setuju 178 356
3 | Tidak Setuju 136 408
4 | Sangat Tidak Setuju 29 116

Jumlah 357 894

Data pada tabel di atas diambil dari hasil angket yang

disebarkan pada peserta didik menunjukkan bahwa skor rata-

rata tentang pengaruh metode bernyanyi dalam meningkatkan

pemahaman pembelajaran PAI adalah 1783 : 714= 2,49 dengan

kategori tidak setuju. Dengan demikian dapat disimpulkan

bahwa peserta didik kelas V mengakui bahwa metode

bernyanyi berpengaruh pada pemahaman pembelajaran PAI.

c. Deskripsi data hasil pre-test dan post-test soal tes PAI

Sebelum mendeskripsikan data, terlebih dahulu menentukan

penilaian sebagai berikut :

1. Nilai komulatif adalah nilai dari setiap item pertanyaan

yang merupakan jawaban dari 21 siswa pada Kkelas

eksperimen maupun kelas kontrol.

2. Presentase adalah nilai komulatif item dibagi dengan nilai

frekuensi dikalikan 100%.

3. Jumlah sampel pada setiap kelas sebanyak 21 siswa dari

nilai skala pengukuran terbesar adalah 10 sedangkan skala

pengukuran terkecil adalah 0. Maka nilai komulatif

terbesar adalah 21 x 10 = 210 dan jumlah nilai komulatif

terkecil adalah 21 x 0 = 0. Adapun nilai prosentase terbesar
adalah (210 : 210) x 100% = 100% dan nilai prosentase
terkecil adalah (0 : 210) x 100% = 0%. Dari prosentase
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tertinggi dan terendah tersebut dapat diperoleh rentang
100% - 0% = 100%. Dari nilai rentang tersebut dibagi
dengan sepuluh skala pengukuran (100% : 10), maka dapat
diperoleh interval presentase sebesar 10%. Dari
perhitungan di atas dapat ditetapkan klasifikasi kriteria
penilaian sebagai berikut :
Tebel 4.13
Prosentase dan Kriteria Penilaian

No Prosentase Kriteria

1 91 -100 Sangat baik
2 81-90 Baik

3. 71-80 Cukup Baik
4 61-70 Kurang Baik
5. 51-60 Tidak Baik

Selanjutnya dihitung nilai kriteriumnya 100 x 21 = 2.100
Keterangan :
100 = skor hitung tertinggi
21 =sampel kelas eksperimen

1) Deskripsi Data Pre-Test Kelas Eksperimen

a) Prosentase

Berdasarkan data pre-test pada kelas eksperimen diperoleh
total perolehan skor 1.185 dengan nilai kriterium 2.100.
Dengan demikian nilai prosentase adalah (1.185 : 2.100) x
100% = 56% dengan kategori kurang baik. Berikut ini
merupakan frekuensi prosentase pre-test pada kelas

eksperimen dengan bantuan SPSS.
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Pre-test Eksperimen

Tabel 4.14
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Prosentase Data Pre-Test Kelas Eksperimen

Cumulative
Frequency Percent Valid Percent Percent

Valid 7,00 1 4,8 4,8 4,8
8,00 1 4,8 4,8 9,5
9,00 1 4,8 4,8 14,3
10,00 3 14,3 14,3 28,6
11,00 7 33,3 33,3 61,9
12,00 4 19,0 19,0 81,0
13,00 2 9,5 9,5 90,5
15,00 1 4,8 4,8 95,2
17,00 1 4,8 4,8 100,0
Total 21 100,0 100,0

b) Ukuran Pemusatan dan Penyebaran Data

Hasil dari perhitungan pemusatan data (mean, median, dan

modus) dan penyebaran data (range, varian, dan standar

deviasi) untuk data pre-test kelas eksperimen dengan

menggunakan bantuan SPSS adalah sebagai berikut :
Tabel 4.15

Output Ukuran Pemusatan dan Penyebaran Data Pre-

Statistics

Pre-test Eksperimen

Test Kelas Eksperimen

Valid
Missing
Mean
Median
Mode

Std. Deviation

Variance

Range

Minimum

Maximum

21

0
56,4286
55,0000
55,00
10,85620
117,857
50,00
35,00
85,00

52




53

Berdasarkan tabel diatas, hasil pre-test sebelum diterapkan
metode bernyanyi pada kelas eksperimen diperoleh nilai tertinggi
85 dan nilai terendah 35. Adapun perhitungan pemusatan data
diperoleh nilai rata-rata 56, median 55, dan modus 55. Penyebaran
data menunjukkan nilai range 50, varian 117,857, dan standar

deviasi 10,858.
c) Display Data (Tabel/Histogram)

Adapun penyajian data pre-test kelas eksperimen melalui
histogram dengan menggunakan bantuan SPSS adalah
sebagai berikut :
Gambar 4.1
Histogram Ukuran Pemusatan dan Penyebaran Data
Pre-Test Kelas Eksperimen

Histogram

Mean = 56 43
Ste. Dev. = 10,856
=21

Frequency

il g

T T T T
30,00 40,00 50,00 60,00 70,00 0,00 90,00
Nilai_Statistika

Gambar di atas menunjukkan gambar histogram yang memiliki

bentuk normal, rata-rata histogram terletak ditengah range

data. Frekuensi data paling tinggi terletak ditengah.

2) Deskripsi Data Post-Test Kelas Eksperimen

a) Prosentase
Berdasarkan data post-test pada kelas eksperimen diperoleh
total perolehan skor 1.910 dengan nilai kriterium 2.100.
Dengan demikian nilai prosentase adalah (1.910 : 2.100) x
100% = 90% dengan kategori baik. Berikut ini merupakan
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Post-test Eksperimen

frekuensi

dengan bantuan SPSS.

Tabel 4.16

Prosentase Data Pre-Test Kelas Eksperimen

54

prosentase post-test pada kelas eksperimen

Cumulative

Frequency Percent Valid Percent Percent
15,00 1 4,8 4,8 4,8
16,00 2 9,5 9,5 14,3
17,00 3 14,3 14,3 28,6
18,00 5 23,8 23,8 52,4
19,00 4 19,0 19,0 71,4
20,00 6 28,6 28,6 100,0
Total 21 100,0 100,0

b) Ukuran Pemusatan dan Penyebaran Data

Hasil dari perhitungan pemusatan data (mean, median,

modus) dan penyebaran data (range, varian, standar deviasi)

untuk data post-test kelas eksperimen menggunakan
bantuan SPSS adalah sebagai berikut :
Tabel 4.17

Output Ukuran Pemustan dan Penyebaran Data Post-

Test Kelas Eksperimen

Statistics

Nilai_Statistika

N Valid
Missing

Mean

Median

Mode

Std. Deviation
Variance

Range
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0
90,9524
90,0000
100,00
8,00298
64,048
25,00
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Minimum ‘ 75,00
Maximum ‘ 100,00

Berdasarkan tabel diatas, hasil post-test setelah diterapkan
metode bernyanyi pada kelas eksperimen diperoleh nilai
tertinggi 100 dan nilai terendah 75. Adapun perhitungan
pemusatan data diperoleh nilai rata-rata 90, median 90, dan
modus 100. Penyebaran data menunjukkan nilai range 25,
varian 64,048, dan standar deviasi 8,00298.
c) Display Data (Tabel/Histogram)
Adapun penyajian data post-test kelas eksperimen melalui
histogram dengan menggunakan bantuan SPSS adalah
sebagai berikut :
Gambar 4.2
Histogram Ukuran Pemustan dan Penyebaran Data
Post-Test Kelas Eksperimen

Histogram

&7 Mean = 90 95
ev. = 5,003
21

Frequency

2]
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70,00 80,00 90,00 100,00 110,00
Nilai_Statistika

Dari gambar di atas, menunjukkan bahwa gambar histogram
memiliki bentuk yang normal, rata-rata histogram terletak
ditengah range data. Frekuensi data paling tinggi terletak di

paling kanan.
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3) Deskripsi Data Pre-Test Kelas Kontrol

a)

Prosentase

Berdasarkan data pre-test pada kelas kontrol diperoleh total
perolehan skor adalah 1.065 dengan nilai keiterium 2.100.
Dengan demikian nilai prosentase adalah (1.065 : 2.100) x
100% = 50% dengan kategori kurang baik. Adapun
frekuensi prosentase pre-test pada kelas kontrol dengan
bantuan SPSS sebagai berikut :

Tabel 4.18

Prosentase Data Pre-Test Kelas Kontrol

Pre-test Kontrol

Cumulative
Freguency Percent Valid Percent Percent
Valid 30,00 1 4,8 4,8 4,8
35,00 2 9,5 9,5 14,3
40,00 2 9,5 9,5 23,8
45,00 1 4,8 4,8 28,6
50,00 6 28,6 28,6 57,1
55,00 4 19,0 19,0 76,2
60,00 3 14,3 14,3 90,5
65,00 1 4,8 4,8 95,2
75,00 1 4,8 4,8 100,0
Total 21 100,0 100,0
b) Ukuran Pemusatan dan Penyebaran Data

Hasil dari perhitungan pemusatan data (mean, median,
modus) dan penyebaran data (range, varian, standar deviasi)
untuk data pre-test kelas kontrol dengan menggunakan
bantuan SPSS adalah sebagai berikut :
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Tabel 4.19
Output Ukuran Pemustan dan Penyebaran Data Pre-

Test Kelas Kontrol

Statistics

Pre-test Kontrol

N Valid 21

Missing 0
Mean 50,7143
Median 50,0000
Mode 50,00
Std. Deviation 10,75706
Variance 115,714
Range 45,00
Minimum 30,00
Maximum 75,00

Berdasarkan tabel diatas, hasil pre-test sebelum diterapkan
metode pembelajaran konvensional pada kelas kontrol diperoleh
nilai tertinggi 75 dan nilai terendah 30. Adapun perhitungan
pemusatan data diperoleh nilai rata-rata 50, median 50, dan modus
50. Penyebaran data menunjukkan nilai range 45, varian 115,714,
dan standar deviasi 10,757.

c) Display Data (Tabel/Histogram)

Adapun penyajian data pre-test kelas kontrol melalui

histogram dengan menggunakan bantuan SPSS adalah sebagai

berikut :
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Gambar 4.3
Histogram Ukuran Pemustan dan Penyebaran Data Pre-
Test Kelas Kontrol

Histogram

57 Wean = 50,71
St Dev. = 10,757
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Gambar di atas menunjukkan gambar histogram yang memiliki
bentuk normal, rata-rata histogram terletak ditengah range
data. Frekuensi data paling tinggi terletak ditengah.

4) Deskripsi Data Post-Test Kelas Kontrol

a) Prosentase

Berdasarkan data post-test pada kelas kontrol diperoleh
total perolehan skor adalah 1.280 dengan nilai keiterium 2.100.
Dengan demikian nilai prosentase adalah (1.280 : 2.100) x
100% = 60% dengan kategori cukup baik. Adapun frekuensi
prosentase post-test pada kelas kontrol dengan bantuan SPSS
sebagai berikut :

Tabel 4.20

Prosentase Data Post-Test Kelas Kontrol

post test kontrol

Cumulative
Freguency Percent Valid Percent Percent
Valid 45,00 2 9,5 9,5 9,5
50,00 4 19,0 19,0 28,6
55,00 2 9,5 9,5 38,1
60,00 4 19,0 19,0 57,1




65,00 2
70,00 4
75,00 2
80,00 1
Total 21

9,5
19,0
9,5
4,8
100,0

9,5
19,0
9,5
4,8
100,0
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66,7
85,7
95,2
100,0

b)

Ukuran Pemusatan dan Penyebaran Data

Hasil dari perhitungan pemusatan data (mean, median,

modus) dan penyebaran data (range, varian, standar

deviasi) untuk data post-test
menggunakan bantuan SPSS adalah sebagai berikut:
Tabel 4.21

kelas

kontrol

dengan

Output Ukuran Pemustan dan Penyebaran Data Post-

Statistics

post_test_kontrol

Variance
Range

Minimum

Maximum

N Valid
Missing

Mean

Median

Mode

Std. Deviation

21

0
60,9524
60,0000
50,0072
10,44259
109,048
35,00
45,00
80,00

Test Kelas Kontrol

Berdasarkan tabel diatas, hasil post-test setelah diterapkan

metode pembelajaran konvensional pada kelas kontrol diperoleh

nilai tertinggi 80 dan nilai terendah 45. Adapun perhitungan

pemusatan data diperoleh nilai rata-rata 60, median 60, dan modus

50. Penyebaran data menunjukkan nilai range 35, varian 109,048,
dan standar deviasi 10,442.
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c) Display Data (Tabel/Histogram)
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Adapun penyajian data post-test kelas kontrol melalui

Gambar 4.3

Test Kelas Kontrol

Histogram

Frequency

T
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T
0,00

histogram dengan menggunakan bantuan SPSS adalah sebagai
berikut :

Histogram Ukuran Pemustan dan Penyebaran Data Post-

Mean = 60 95
Std. Dev.=10,443
N=21

Gambar di atas menunjukkan gambar histogram yang memiliki

bentuk normal, rata-rata histogram terletak ditengan range data.

Frekuensi data paling tinggi terletak ditengah.

Tabel 4.22
Data hasil pre-test dan post-test soal tes PAI kelas Eksperimen
No Nama Nilat
Pre-test Post-test

1. Ahmad Zaelani 65 95

2. Deriski 65 80

3. Dirly Maulana 45 95

4. Febriyansah 55 80

5. Raffardhan Atalla 85 100

6. Revan Karwandi 40 90
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7. Rizki Mulana 55 85
8. Sabda Narendro 55 85
9. Claudia Silviana 50 100
10. | Delia Afriliani 55 85
11. | Denis Hasifa 60 80
12. | Elsa Ayuni 75 100
13. | Intan Amalia 55 95
14. | Keyla Zahrotunizza 60 100
15. | Meiza Azzahra 35 90
16. | Nadira Paramita 60 75
17. | Nur Amira 50 95
18. | Nur Intan Rahayu 55 90
19. | Putri Aulia 50 100
20. | Rena Helpiyani 60 90
21. | Siti Rohmah 55 100
Tabel 4.23
Data hasil pre-test dan post-test soal tes PAI kelas Kontrol
No Nama ila
Pre-test Post-test
1. Axella Narendra 50 60
2. Fauzan Desvara 35 50
3. Igbal Radiansyah 60 60
4. Muhamad Adli 50 75
5. Muhammad Rival 55 70
6. Rayhan Nauval Dwiputra 50 70
7. Solehuddin 60 80
8. Wahyudin 55 70
9. Deriska 35 45
10. | Dini Afriani 40 50
11. | Elsa Febriyani 40 55
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12. | Erismawati 50 65
13. | Fenytha Putri 30 50
14. | Fitri Apriliani 55 70
15. | Fitria Agustiani 45 45
16. | Latipah 50 50
17. | Melisha Rindiyani 75 75
18. | Regina Rismandar 55 55
19. | Sisil Dwi Destiani 50 60
20. | Sopiyani Lestari 65 65
21. | Siti Arumi 60 60

3. Uji Prasyarat Analisis
a. Uji Normalitas

Uji normalitas ini dilakukan untuk melihat apakah data pre-test
dan post-test siswa berdistribusi normal atau tidak. Dalam
penelitian ini, peneliti menggunakan uji Kolmogorov-Smirnov
dengan taraf signifikasi yaitu 0,05 dengan bantuan SPSS. Adapun
hasil uji normalitas pada penelitian ini sebagai berikut :

Tabel 4.24
Uji Normalitas Data Pre-Test dan Post-Test

Tests of Normality

Kolmogorov-Smirnov?
Kelas
Statistic df Sig.
Pre-Test Eksperimen (Metode Bernyanyi) ,181 21 ,072
Post-Test Eksperimen (Metode Bernyanyi) ,170 21 117
Pre-Test Kontrol (Konvensional) ,188 21 ,051
Post-Test Kontrol (Konvensional) ,140 21 ,200°

Berdasarkan tabel di atas, dapat diketahui bahwa nilai signifikasi
pre-test di kelas eksperimen vyaitu 0,072 dan post-test di kelas

eksperimen yaitu 0,117. Sementara nilai signifikasi pre-test di kelas
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kontrol yaitu 0,051 dan post-test di kelas kontrol yaitu 0,200. Nilai-nilai

tersebut lebih besar dari taraf signifikasi 0,05. Sehingga dapat

disimpulkan bahwa data yang diteliti berdistribusi normal.

b. Uji Homogenitas

Uji homogenitas dilakukan untuk mengetahui apakah dua

kelompok sampel yang digunakan dalam penelitian ini memiliki

varians yang sama atau tidak. Uji homogenitas menggunakan data

pre-test dan post-test. Uji homogenitas ini dilakukan melalui

software SPSS yakni Test of Homogeneity of Variances dengan

nilai signifikasi 0,05. Adapun hasil uji homogenitas pada penelitian

ini sebagai berikut:

Tabel 4.25

Uji Homogenitas Data Pre-Test dan Post-Test

Test of Homogeneity of Variance

Levene
Statistic dfl df2 Sig.
Hasil Based on Mean 1,811 1 40 ,186
Belajar Based on Median 1,488 1 40 ,230
Siswa Based on Median and 1,488 1 37,020 ,230
with adjusted df
Based on trimmed mean 1,726 1 40 ,196

Berdasarkan tabel di atas, dapat diketahui bahwa nilai signifikasi

yang diperoleh yaitu 0,186. Nilai yang diperoleh lebih besar dari

taraf signifikasi 0,05. Dengan demikian, dapat disimpulkan bahwa

data yang diteliti bersifat homogen.

4. Pengujian Hipotesis Penelitian

a. Analisis Data Sebelum Perlakuan

Berdasarkan hasil analisis data perolehan skor hasil.belajar.siswa

sebelum diberikan perlakuan (pre-test) pada kelas eksperimen

maupun kelas kontrol didapatkan data sebagai berikut :

Tabel 4.26

Data Perolehan Pre-Test Kelas Eksperimen dan Kelas Kontrol

Kelas Eksperimen

Kelas Kontrol
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Jumlah Soal 20 Jumlah Soal 20

Jumlas Sampel 21 Jumlas Sampel 21

Skor Maksimal 2100 Skor Maksimal 2100

Skor Pencapaian 1185 Skor Pencapaian | 1065
Prosentase Skor 56% Prosentase Skor | 50%
Kategori Skor Tidak Baik | Kategori Skor Tidak Baik
Skor Rta-rata 56,4286 Skor Rata-rata 50,7143

Untuk Ilebih kelas
eksperimen dan kelas kontol dapat diamati pada tabel statistic

berikut :

jelasnya mengetahui rata-rata pre-test

Tabel 4.27
Rata-rata Nilai Pre-Test Kelas Eksperimen dan Kelas Kontrol

Group Statistics

Std. Error
Kelas N Mean Std. Deviation Mean
Hasil Belajar Siswa Kelas Eksperimen 21| 56,4286 10,85620 2,36902
Kelas Kontrol 21| 50,7143 10,75706 2,34738

Hasil perolehan skor pre-test pada kelas eksperimen yaitu 1.185
dengan rata-rata 56 (56%) dan kategori tidak baik. Sementara skor
pre-test pada kelas kontrol yaitu 1.065 dengan rata-rata 50 (50%)
dan kategori tidak baik. Dari data tersebut menunjukkan bahwa
hasil skor pre-test pada kelas eksperimen dan kelas kontrol
memiliki selisih yang tidak jauh berbeda, sehingga kedua kelas
tersebut layak digunakan dalam penelitian. Adapun analisis pre-test
kelas eksperimen dan kelas kontrol dengan menggunakan bantuan
software SPSS (Independent Sample T-Test) dengan hipotesisi

sebagai berikut :

® Jika t hitung > t tabel atau nilai sig. (2 tailed) < 0,05, maka rata-

rata skor Pre-Test berbeda secara signifikan
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® Jika t hitung <t tabel nilai sig. (2 tailed) > 0,05, maka rata-rata
skor Pre-Test tidak berbeda secara signifikan
Tabel. 4.28

Analisis Pre-Test Kelas Eksperimen dan Kelas Kontrol

Independent Samples Test

Levene's Test
for Equality of

Variances t-test for Equality of Means

95%
Std. Confidence
Sig. | Mean | Error | Interval of the

(2- | Differe | Differe Difference

Hasil Belajar

Siswa

F Sig. t Df | tailed) | nce nce Lower | Upper
Equal ,044 ,835|1,71| 40 ,094 | 5,7142 | 3,3350 -1 12,454
variances 3 9 3| 1,0260 64
assumed 7
Equal 1,71(39,9| ,094|5,7142| 3,3350 -1 12,454
variances 3| 97 9 31| 1,0260 66
not assumed 9

Berdasarkan tabel di atas diperoleh bahwa t hitung 1.713 < 2,093
dengan nilai sig. (2 tailed) 0,094 > 0.05, maka dapat disimpulkan
bahwa tidak terdapat perbedaan yang signifikan skor pre-test antara
kelas eksperimen dan kelas kontrol.

Analisis Data Setelah Perlakuan

Berdasarkan hasil analisis data perolehan skor hasil belajar siswa di kelas
eksperimen maupun kelas kontrol setelah diberikan perlakuan (post-

test), maka didapatkan data sebagai berikut:

Tabel 4.29
Data Perolehan Post-Test Kelas Eksperimen dan Kelas Kontrol
Kelas Eksperimen Kelas Kontrol
Jumlah Soal 20 Jumlah Soal 20
Jumlas Sampel 21 Jumlas Sampel 21
Skor Maksimal 2100 Skor Maksimal 2100
Skor Pencapaian | 1910 Skor Pencapaian | 1280
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Prosentase Skor 90% Prosentase Skor | 60%
Kategori Skor Sangat Baik | Kategori Skor Tidak Baik
Skor Rata-rata 90 Skor Raata-rata 60

Untuk lebih kelas
eksperimen dan kelas kontol dapat diamati pada tabel statistic

berikut :

jelasnya mengetahui rata-rata pre-test

Tabel 4.30

Rata-rata Nilai Post-Test Kelas Eksperimen dan Kelas Kontrol

Group Statistics

Std. Std. Error
Kelas N Mean Deviation Mean
Hasil Belajar Kelas 21| 90,9524 8,00298 1,74639
Siswa Eksperimen
Kelas Kontrol 21| 60,9524 10,44259 2,27876

Hasil perolehan skor post-test pada kelas eksperimen yaitu
1.910 dengan rata-rata 90 (90%) dan kategori sangat baik.
Sementara skor post-test pada kelas kontrol yaitu 1.280 dengan
rata-rata 60 (60%) dan kategori kurang baik. Dari data tersebut
menunjukkan bahwa hasil skor post-test pada kelas eksperimen dan
kelas kontrol terdapat perbedaan prosentase skor yang diperoleh.
Adapun analisis post-test kelas eksperimen dan kelas kontrol
dengan menggunakan bantuan software SPSS (Independent Sample
T-Test) dengan hipotesisi sebagai berikut:
® Jika t hitung > t tabel atau nilai sig. (2 tailed) < 0,05, maka

rata-rata skor Post-Test berbeda secara signifikan

® Jika t hitung < t tabel atau nilai sig. (2 tailed) > 0,05, maka

rata-rata skor Post-Test tidak berbeda secara signifikan
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Tabel. 4.31

Analisis Post-Test Kelas Eksperimen dan Kelas Kontrol
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Independent Samples Test

Levene's Test

for Equality of

Variances t-test for Equality of Means
95%
Std. Confidence
Sig. Mean | Error | Interval of the
(2- | Differe | Differe Difference
F Sig. t df | tailed) | nce nce | Lower | Upper
Hasil Equal 1,811| ,186(10,4| 40| ,000| 30,000 2,8710| 24,197 35,802
Belajar variances 49 00 0 50 50
Siswa assumed
Equal 10,4|37,4| ,000 | 30,000 | 2,8710| 24,185| 35,814
variances 49| 68 00 0 26 74
not assumed

Berdasarkan tabel di atas diperoleh t hitung 10,449 > 2,093 dengan
nilai sig. (2 tailed) 0,000 < 0.05, maka dapat disimpulkan bahwa

terdapat perbedaan yang signifikan skor Post-Test antara kelas

eksperimen dan kelas kontrol.

c. Analisis Data Peningkatan (Pre-Test dan Post-Test)

Berdasarkan hasil analisis data perolehan skor hasil belajar siswa

sebelum diberikan perlakuan (Pre-test) dan sesudah diberikan

perlakuan (Post-test) baik di kelas eksperimen maupun di kelas

kontrol maka didapatkan data sebagai berikut:

1) Kelas Eksperimen

Hasil skor

pre-test

kelas

eksperimen adalah 1.185

sedangkan skor post-test kelas eksperimen adalah 1.910.

Dengan demikian terjadi peningkatan skor sebesar 725

poin. Jika skor peningkatan dibagi dengan skor maksimal
kemudian dikali 100% {(725 : 2.100) x 100% = 34%}.

Maka dapat ditarik kesimpulan bahwa terdapat peningkatan
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hasil belajar siswa setelah dilakukan perlakuan (Metode
Bernyanyi) yaitu sebesar 34%
Kelas Kontrol
Hasil skor pre-test kelas kontrol adalah 1.065 sedangkan
skor post-test kelas kontrol adalah 1.280. Dengan demikian
terjadi peningkatan skor sebesar 215 poin. Jika skor
peningkatan dibagi dengan skor maksimal kemudian dikali
100% {(215 : 2.100) x 100% = 10%}. Maka dapat ditarik
kesimpulan bahwa terdapat peningkatan hasil belajar siswa
setelah dilakukan perlakuan (Metode Bernyanyi) vyaitu
sebesar 10%.

Adapun analisis peningkatan hasil belajar siswa
pada kelas eksperimen dan kelas kontrol dengan
menggunakan bantuan software SPSS (Paired Sample T-

Test) dengan hipotesisi sebagai berikut :

® Jika t hitung > t tabel atau nilai sig. (2 tailed) < 0,05,
maka terdapat peningkatan hasil belajar siswa secara
signifikan

® Jika t hitung <t tabel atau nilai sig. (2 tailed) > 0,05,
maka tidak terdapat peningkatan hasil belajar siswa
secara signifikan

Tabel 4.32
Analisis Data Peningkatan Hasil Belajar Siswa pada

Kelas Eksperimen dan Kelas Kontrol

Paired Samples Test

Paired Differences

95% Confidence

Std. Std. Interval of the
Deviatio Error Difference Sig. (2-
Mean n Mean Lower Upper df tailed)
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Pair 1 | Pre-Test 12,8359 | 2,80104 - - - 20 ,000
Eksperimen - 34,523 6 40,36667 | 28,68095| 12,32
Post-Test 81 5
Eksperimen
Pair 2 | Pre-Test Kontrol 8,28797| 1,80858 -| -6,46546 - 20 ,000
- Post-Test 10,238 14,01073 5,661
Kontrol 10
Berdasarkan analisis software SPSS di atas dapat

disimpulkan sebagai berikut :

1) Pada kelas eksperimen diperoleh nilai t hitung 12.325 >

2,093 dengan sig. 0,000 < 0,05, maka dapat disimpulkan

bahwa terdapat peningkatan hasil belajar secara signifikan

dengan menggunakan model pembelajaran scramble.

2)

Pada kelas kontrol diperoleh nilai t hitung 5.661 > 2,093

dengan sig. 0,000 < 0,05, maka dapat disimpulkan bahwa

terdapat peningkatan hasil belajar siswa secara signifikan

dengan menggunakan model pembelajaran konvensional
d. Perubahan Hasil

Perubahan hasil pada penelitian ini dapat dilihat dari uji Paired

Sample Test yang dilakukan terhadap data yang diperoleh pada

kelas eksperimen maupun kelas kontrol. Untuk lebih jelasnya

mengetahui rata-rata pre-test dan post-test kelas eksperimen dan

kelas kontol dapat dilihat pada tabel statistic berikut :

Tabel 4.33

Analisis Data Pre-Test dan Post-Test Kelas Eksperimen dan

Kelas Kontrol

Paired Samples Statistics

Mean N Std. Deviation | Std. Error Mean

Pair 1 Pre-Test Eksperimen 56,4286 21 10,85620 2,36902
Post-Test Eksperimen 90,9524 21 8,00298 1,74639

Pair 2 Pre-Test Kontrol 50,7143 21 10,75706 2,34738
Post-Test Kontrol 60,9524 21 10,44259 2,27876

Dari tabel di atas, dapat dipahami bahwa sebelum diberi

perlakuan metode bernyanyi, nilai rata-rata pada kelas eksperimen
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yaitu 56. Akan tetapi setelah diberi perlakuan dengan
menggunakan metode bernyanyi dalam pembelajaran PAI rata-rata
nilai (post-test) pada kelas eksperimen mengalami kenaikan
menjadi 90. Sehingga terdapat perubahan nilai rata-rata hasil
belajar siswa pada kelas eksperimen.

Selain itu, nilai rata-rata yang diperoleh sebelum menggunakan
metode konvensional dalam pembelajaran PAI pada kelas kontrol
yaitu 50. Dan setelah melakukan proses pembelajaran konvensional
pada kelas kontrol dihasilkan nilai rata-rata (post-test) sebesar 60.
Maka dari itu, terdapat perubahan nilai rata-rata hasil belajar siswa
pada kelas kontrol. Namun perubahan yang terjadi pada kelas
kontrol tidak lebih besar dari perubahan yang tejadi pada kelas
eksperimen.

Adapun untuk mengukur tingkat efektivitas metode bernyanyi pada
mata pelajaran PAI kelas V di SDN Karanganyar 1 dilakukan
dengan melakukan Uji N-Gain Score. Adapun hasil uji N-Gain
Score dengan bantuan SPSS dengan ketentuan tingkat efektivitas

sebagai berikut :

Tabel 4.34
Kategori Tafsiran Efektivitas N-Gain
Prosentase Tafsiran
<40 Tidak Efektif
40-55 Kurang Efektif
56-75 Cukup Efektif
>76 Efektif
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Tabel 4.35

Hasil Perhitungan Uji N-Gain Score

Kelas Eksperimen Kelas Kontrol
No | N-Gain Score (%) No N-Gain Score
(%)

1 85,71 1 20,00

2 42,86 2 23,00

3 90,91 3 0,00

4 55,56 4 50,00

5 100,00 5 33,33

6 83,33 6 40,00

7 66,67 7 50,00

8 66,67 8 33,33

9 100,00 9 15,38

10 | 66,67 10 16,67

11 | 50,00 11 25,00

12 100,00 12 30,00

13 | 88,89 13 28,57

14 100,00 14 33,33

15 | 84,62 15 0,00

16 | 37,50 16 0,00

17 | 90,00 17 0,00

18 77,78 18 0,00

19 100,00 19 20,00

20 | 75,00 20 0,00

21 100,00 21 0,00
Mean | 79,1501 Mean | 19,9381
Max | 100,00 Max | 50,00
Min | 37,50 Min | 0,00
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Dari tabel hasil perhitungan N-Gain Score tersebut, dapat diketahui bahwa nilai rata-
rata N-Gain Score pada kelas eksperimen (metode bernyanyi) adalah 79,1501 atau 79,1%
tergolong dalam kategori efektif.

Sementara untuk nilai rata-rata N-Gain Score pada kelas kontrol (metode
konvensional) adalah 19,9381 atau 19,9% tergolong dalam kategori tidak efektif. Maka
dapat disimpulkan bahwa penggunaan metode bernyanyi efektif dalam meningkatkan hasil
belajar siswa mata pelajaran PAI kelas V di SDN Karanganyar 1 Karawang. Sedangakan
penggunaan metode konvensional tidak efektif dalam meningkatkan hasil belajar siswa

mata pelajaran PAI kelas V di SDN Karanganyar 1 Karawang
C. Analisis Data (Pembahasan)

1. Analisis data kelas eksperimen menggunakan Soal Tes
Hasil belajar siswa pada mata pelajaran pelajaran Pendidikan

Agama Islam berdasarkan data yang diperoleh melalui uji prosedur
dengan menggunakan instrumen tes pilihan ganda sebanyak 20 soal
yang diujikan kepada 21 siswa kelas V di SDN Karanganyar 1 sebagai
sampel menggunakan metode bernyanyi. Berikut disajikan tabel

analisis pada kelas eksperimen:

Tabel 36

Analisis Data Kelas Eksperimen

Statistics

Pre-Test Post-Test

Eksperimen Eksperimen
N Valid 21 21
Missing 0 0
Mean 56,4286 90,9524
Std. Error of Mean 2,36902 1,74639
Median 55,0000 90,0000
Mode 55,00 100,00
Std. Deviation 10,85620 8,00298
Variance 117,857 64,048
Range 50,00 25,00
Minimum 35,00 75,00
Maximum 85,00 100,00
Sum 1185,00 1910,00
Prosentase 56% 90%
Kategori Skor dan Kurang Baik Baik

Prosentase
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Uji Normalitas Normal Normal
Uji Homogenitas Homogen
Peningkatan Skor 725
Presentase 34%
peningkatan

Hasi skor pre-test kelas eksperimen adalah 1.185 sedangkan skor
post-test kelas eksperimen adalah 1.910. Dengan demikian terjadi
peningkatan skor sebesar 725 poin. Jika skor peningkatan dibagi
dengan skor maksimal kemudian dikali 100% {(725 : 2.100) x
100% = 34%}. Maka dapat ditarik kesimpulan bahwa terdapat
peningkatan hasil belajar siswa setelah dilakukan perlakuan

(Metode Bernyanyi) yaitu sebesar 34%.

Analisis data kelas kontrol menggunakan Soal Tes

Hasil belajar siswa pada mata pelajaran Pendidikan Agama Islam
berdasarkan data yang diperoleh melalui uji prosedur dengan
menggunakan instrumen tes pilihan ganda sebanyak 20 soal yang
diujikan kepada 21 siswa kelas V di SDN Karanganyar 1 sebagai
sampel menggunakan metode pembelajaran konvensional. Berikut
disajikan tabel analisis pada kelas kontrol:

Tabel 37
Analisis Data Kelas Kontrol

Statistics

Pre-Test
Kontrol Post-Test Kontrol
N Valid 21 21
Missing 0 0
Mean 50,7143 60,9524
Std. Error of Mean 2,34738 2,27876
Median 50,0000 60,0000
Mode 50,00 50,002
Std. Deviation 10,75706 10,44259
Variance 115,714 109,048
Range 45,00 35,00
Minimum 30,00 45,00
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Maximum 75,00 80,00
Sum 1065,00 1280,00
Prosentase 50% 60%
Kategori Skor dan Kurang Baik Kurang Baik
Prosentase

Uji Normalitas Normal Normal
Uji Homogenitas Homogen
Peningkatan Skor 215
Presentase 10%
Peningkatan

Hasil skor pre-test kelas kontrol adalah 1.065 sedangkan skor post-
test kelas kontrol adalah 1.280. Dengan demikian terjadi
peningkatan skor sebesar 215 poin. Jika skor peningkatan dibagi
dengan skor maksimal kemudian dikali 100% {(215 : 2.100) x
100% =

peningkatan hasil belajar siswa setelah dilakukan perlakuan

10%}. Maka dapat ditarik kesimpulan bahwa terdapat

(Metode Konvensional) yaitu sebesar 10%.

. Analisis data kelas Eksperimen menggunakan Angket
Hasil

Pendidikan Agama Islam berdasarkan data yang diperoleh melalui

penelitian menggunakan angket pada mata pelajaran

uji prosedur dengan menggunakan instrumen angket sebanyak 34
butir yang diujikan kepada 21 siswa kelas V di SDN Karanganyar
1 sebagai sampel menggunakan metode beryanyi. Berikut disajikan
tabel analisis pada kelas eksperimen:

Tabel 4.38

Analisis Data Kelas Eksperimen

Statistics
Pre-Test Post-Test

Eksperimen Eksperimen

N Valid 21 21
Missing 0 0

Mean 82,19 120,10
Std. Error of 1,767 ,864
Mean
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Median 80,00 120,00
Mode 80 119
Std. Deviation 8,097 3,961
Variance 65,562 15,690
Range 30 16
Minimum 73 114
Maximum 103 130
Sum 1726 2522
Hasil 2,41 3,53
Kategori Tidak berpengaruh berpengaruh
Peningkatan 796
Skor

Presentase 27%
Peningkatan

Hasil skor pre-test kelas eksperimen adalah 1.726
sedangkan skor post-test kelas eksperimen adalah 2.522. Dengan
demikian terjadi peningkatan skor sebesar 796 poin. Jika skor
peningkatan dibagi dengan skor maksimal kemudian dikali 100%
{(796 : 2.856) x 100% = 27%}. Maka dapat ditarik kesimpulan
bahwa metode bernyanyi berpengaruh pada peningkatan hasil
belajar siswa kelas eksperimen setelah dilakukan perlakuan metode

bernyanyi yaitu sebesar 27%.

. Analisis data kelas kontrol menggunakan Angket

Hasil penelitian menggunakan angket pada mata pelajaran
Pendidikan Agama Islam berdasarkan data yang diperoleh melalui
uji prosedur dengan menggunakan instrumen angket sebanyak 34
butir yang diujikan kepada 21 siswa kelas V di SDN Karanganyar
1 sebagai sampel menggunakan metode beryanyi. Berikut disajikan

tabel analisis pada kelas kontrol:
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Tabel 4.39

Analisis Data Kelas Eksperimen

Statistics
Pre-Test Post-Test
Eksperimen Eksperimen

N Valid 21 21
Missing 0 0
Mean 82,14 84,86
Std. Error of Mean ,785 ,947
Median 82,00 84,00
Mode 86 84
Std. Deviation 3,596 4,339
Variance 12,929 18,829
Range 13 20
Minimum 75 76
Maximum 88 96
Sum 1725 1782
Hasil 2,41 2,49
Kategori Tidak Tidak
Berpengaruh Berpengaruh
Peningkatan skor 57
presentase 1%

Peningkatan

Hasil skor pre-test kelas kontrol adalah 1.725 sedangkan
skor post-test kelas eksperimen adalah 1.782. Dengan demikian
terjadi peningkatan skor sebesar 57 poin. Jika skor peningkatan
dibagi dengan skor maksimal kemudian dikali 100% {(57 : 2.856)
x 100% = 1%}. Maka dapat ditarik kesimpulan bahwa metode
bernyanyi tidak berpengaruh pada peningkatan hasil belajar siswa

kelas kontrol.
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Bab V
PENUTUP
A. Simpulan

Berdasarkan hasil uji prosedur dan uji hipotesis terhadap penerapan

metode bernyanyi terhadap hasil belajar siswa, diperoleh data sebagai

berikut :

1. Penggunaan metode bernyanyi dalam pelajaran Pendidikan Agama
Islam yaitu dengan mengubah materi menjadi sebuah lagu yang dapat
memudahkan siswa dalam menyerap dan memahami materi sehingga
siswa bisa merasakan pembelajaran yang menyenangkan dan dapat
menumbuhkan minat belajar siswa dan meningkatkan hasil belajar
siswa. Hal ini dapat dibuktikan dengan adanya perolehan skor rata-rata
pre-test dari kelas eksperimen 1.726 : 714 = 2,4. Sedangkan hasil skor
rata-rata post-test 2.523 : 714 = 3,5. Adapun perolehan skor rata-rata
pre-test dari kelas kontrol ialah 1.756 : 714 = 2,4. Dan skor rata-rata
post-test 1.783 : 714 = 2,49.

Dari hasil penelitian ini membuktikan bahwa metode bernyanyi
mempengaruhi hasil belajar siswa kelas V dalam mata pelajaran
Pendidikan Agama Islam.

2. Analisis data sebelum menggunakan metode bernyanyi diperoleh t
hitung 1.713 < 2,093 (t tabel) dengan nilai sig. (2 tailed) 0,094 > 0.05,
maka dapat disimpulkan bahwa tidak terdapat perbedaan yang
signifikan skor pre-test antara kelas eksperimen dan kelas kontrol.

3. Analisis data setelah menggunakan metode bernyanyi diperoleh t
hitung 10,449 > 2,093 (t tabel) dengan nilai sig. (2 tailed) 0,000 < 0.05,
maka dapat disimpulkan bahwa terdapat perbedaan yang signifikan
skor post-test antara kelas eksperimen dan kelas kontrol.

4. Peningkatan hasil belajar siswa pada kelas eksperimen dengan
menggunakan metode bernyanyi dan kelas kontrol dengan
menggunakan metode konvensional melalui uji N-Gain Score adalah

sebagai berikut :
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a.

B. Saran
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Nilai rata-rata N-Gain Score untuk kelas eksperimen (metode
bernyanyi) adalah sebesar 79,1501 atau 79% termasuk dalam
kategori efektif. Dengan nilai N-Gain Score minimal 37% dan
maksimal 100%. Maka dapat disimpulkan bahwa penggunaan
metode bernyanyi berpengaruh dalam meningkatkan hasil belajar
siswa pada pelajaran Pendidikan Agama Islam kelas V di SDN
Karanganyar 1.

Nilai rata-rata N-Gain Score untuk kelas kontrol (metode
konvensional) adalah sebesar 19,9381 atau 19,9% termasuk dalam
kategori tidak efektif. Dengan nilai N-Gain Score minimal 0% dan
maksimal 50%. Maka dapat disimpulkan bahwa penggunaan
metode konvensional tidak efektif dalam dalam meningkatkan
hasil belajar siswa pada pelajaran Pendidikan Agama Islam kelas V

di SDN Karanganyar 1.

Beberapa saran yang dapat peneliti berikan untuk kemajuan pendidikan

khususnya untuk kemajuan siswa dalam proses pembelajaran adalah

sebagai berikut:

1. Untuk kepala sekolah, penulis mengharapkan agar hasil penelitian ini

dijadikan sebagai bahan acuan untuk memperbaiki penggunaan metode

pembelajaran sehingga hasil belajar siswa dapat lebih meningkat.

2. Untuk guru, penulis mengharapkan agar hasil penelitian ini dijadikan

sebagai bahan acuan untuk dapat menggunakan metode pembelajaran

lebih bervariatif.

3. Untuk siswa, penulis mengharapkan agar bisa lebih meningkatkan

semangat belajar agar dapat memperoleh nilai atau prestasi belajar

yang memuaskan terutama tercipta pengalaman belajar yang baik.
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KISI-KISI ANGKET VARIABEL X (Metode Bernyanyi) dan VARIABEL Y (Hasil Belajar)

Butir soal Jumlah
No Aspek Indikator Positif | Negatif - S
1 | Kognitif . Siswa mampu mengetahui materi yang disampaikan | 1, 2,3, | 7,8, 9, 6 12
guru 4,56 | 10,11,
. Siswa mampu memahami materi yang disampaikan 12
guru
. Siswa mampu mengulang kembali materi yang
disampaikan guru.
. Siswa mampu  menganalisis materi  yang
disampaikan guru
. Siswa mampu membuat hal yang baru berdasarkan
materi yang disampaikan guru
. Siswa mampu melakukan evaluasi terhadap materi
yang disampaikan guru
2 | Afektif . Siswa menerima materi yang disampaikan dengan | 13, 14, | 18, 19,, 5 10
penuh keceriaan 15,16, | 20, 21,
. Siswa mampu menjawab setiap pertanyaan yang 17 22
ditanyakan oleh guru
. Siswa mampu menilai perilaku yang positif dari
materi yang disampaikan
. Siswa mampu mengemukakan pendapatnya setelah
guru menjelaskan materi
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. Siswa mampu menunjukan sikap yang sesuai

dengan materi yang disampaikan oleh guru

Psikomotorik . Siswa mampu memperagakan materi yang | 23,25, | 24, 26, 6 6 12
disampaikan oleh guru 27,29, | 28, 30,
. Siswa mampu melakukan gerakan sesuai dengan | 31,33 | 32,34
materi yang disampaikan
. Siswa mampu melakukan tindakan yang sesuai
dengan materi yang disampaikan
. Siswa melakukan ketepatan menjawab pertanyaan
yang baik setelah memperhatikan materi yang
disampaikan
. Siswa memiliki keterampilan sederhana hingga
keterampilan kompleks setelah guru menyampaikan
materi
. Siswa mampu melakukan gerakan secara refleks
Jumlah 17 17 34
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KISI-KISI INSTRUMEN PRE-TEST dan POST-TEST VARIABEL Y (Hasil

Mata Pelajaran
Kelas

Bentuk soal

Belajar Siswa)

: Pendidikan Agama Islam

: Pilihan Ganda

Materi

Indikator

Bentuk
Soal

No Soal

Jumlah

Mengenal
Rasul- Rasul
Allah SWT

Siswa mampu
meyakini
keberadaan rasul
Allah dan Ululazmi

PG

1,2,3,4

Siswa mampu
menjabarkan makna
rasul

PG

56,7,8

Siswa mampu
menjabarkan tugas
rasul

PG

9,10, 11, 12

Siswa mampu
menyebutkan rasul
Ululazmi

PG

13, 14, 15,
16

Siswa mampu
mengimplementasik
an sikap terpuji para
rasul Allah dan
Ululazni dalam
kehidupan sehari-
hari

PG

17, 18, 19,
20

Jumlah

20
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INSTRUMEN PRE-TEST dan POST-TEST
ANGKET UNTUK SISWA

1. Bacalah penyataan dengan baik

2. Pilihlah salah satu jawaban alternatif yang sesuai dengan memberi
tanda (v ) pada kolom alternatif jawaban

3. Jawablah dengan jujur karena tidak akan mempengaruhi nilai raport
atau kenaikan kelas adik-adik

4. Jawaban angket yang telah diisi akan dirahasiakan.

Keterangan
SS : Sangat Setuju
S : Setuju
TS : Tidak Setuju
STS : Sangat Tidak Setuju
Nama
Kelas 0
No Pernyataan SS TS | STS
1 | Saya memahami materi beriman kepada
Rasul Allah melalui bernyanyi yang
disampaikan oleh guru
2 | Saya dapat mengulang kembali materi
beriman kepada Rasul Allah setelah guru
mennyampaikan materi melalui metode
bernyanyi
3 | Saya mampu membiasakan berperilaku jujur
sesuai dengan ajaran Rasul dalam sehari-hari
4 | Saya dapat merangkum materi beriman
kepada Rasul Allah dari penjelasan guru
melalui bernyanyi
5 | Saya mampu meningkatkan hasil ujian PAI
melalui bernyanyi
6 | Saya dapat mengerjakan pekerjaan rumah
(PR) secara mandiri
7 | Saya kurang memahami materi beriman
kepada Rasul Allah yang disampaikan guru
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melalui bernyanyi

Saya tidak mampu mengulang kembali
materi beriman kepada Rasul Allah setelah
guru mennyampaikan materi melalui metode
bernyanyi

Saya  belum  mampu  membiasakan
berperilaku jujur dalam kehidupan sehari-
hari

10

Saya tidak dapat merangkum materi beriman
kepada Rasul Allah dari penjelasan guru
melalui bernyanyi

11

Saya belum mampu meningkatkan hasil
ujian PAI melalui bernyanyi

12

Saya tidak bisa mengerjakan pekerjaan
rumah (PR) secara mandiri

13

Saya mengikuti proses pembelajaran dengan
penuh keceriaan ketika guru menyampaikan
materi melalui bernyanyi

14

Saya selalu menjawab pertanyaan yang
ditanyakan guru

15

Saya meyakini adanya Rasul yang diutus
oleh Allah sesuai dengan materi Yyang
disampaikan guru

16

Saya dapat mengemukakan pendapat pada
saat pembelajaran

17

Saya selalu tepat waktu datang ke sekolah

18

Saya tidak mengikuti proses pembelajaran
dengan baik ketika guru menyampaikan
materi melalui bernyanyi

19

Saya tidak menjawab pertanyaan Yyang
ditanyakan guru

20

Saya belum meyakini adanya Rasul yang
diutus oleh Allah sesuai dengan materi yang
disampaikan guru

21

Saya tidak berani mengemukakan pendapat
pada saat pembelajaran

22

Saya selalu terlambat datang ke sekolah

23

saya mengikuti gerakan sesuai arahan guru
secara tidak langsung

24

Saya mampu menyanyi sambil melakukan
gerakan sesuai dengan arahan guru
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25

Saya mampu mencoba gerakan-gerakan
yang sesuai dengan materi yang disampaikan
guru melalui bernyanyi

26

Saya dapat menjawab pertanyaan guru
dengan tepat setelah guru menyampaikan
materi melalui bernyanyi

27

Saya mampu melakukan gerakan-gerakan
sederhana yang dicontohkan guru pada saat
belajar

28

Saya dapat meniru gerakan-gerakan yang
dicontohkan guru dengan baik

29

Saya tidak dapat mengikuti gerakan sesuai
arahan guru

30

Saya tidak bisa menyanyi sambil melakukan
gerakan sesuai dengan arahan guru

31

Saya tidak mampu mencoba gerakan-
gerakan yang sesuai dengan materi yang
disampaikan guru melalui bernyanyi

32

Saya tidak dapat menjawab pertanyaan guru
dengan tepat setelah guru menyampaikan
materi melalui bernyanyi

33

Saya tidak mampu melakukan gerakan-
gerakan sederhana yang dicontohkan guru
pada saat belajar

34

Saya tidak dapat meniru gerakan-gerakan
yang dicontohkan guru dengan baik
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INSTRUMEN PRE-TEST dan POST-TEST VARIABEL Y (Hasil Belajar Siswa)

Mata pelajaran : Pendidikan Agama Islam dan Budi Pekerti
Materi : Beriman kepada Rasul-rasul Allah SWT
Kelas/ Semester 1 VI2

Jumlah Soal : 20

Nama

Kelas

Berilah tanda (X) pada huruf a, b, ¢, atau d di depan jawaban yang benar !

1. Iman kepada rasul-rasul Allah SWT merupakan rukun iman yang ke ...

a. 4 b.3 c.2 d1l
2. Jumlah rasul yang wajib diketahui ada ...
a. 10 b. 20 c. 25 d. 26
3. Beriman kepada rasul harus diiringi dengan perbuatan ...
a. meneladani akhlak rasul c. membaca kisah rasul
b. mencari keberadaan rasul d. Mengingat sejarah rasul
4. Allah SWT memberi kelebihan dan keistimewaan kepada para rasul
berupa ...
a. kekuatan b. karomah c. harta benda d. mukjizat

5. Hamba Allah SWT yang diutus oleh Allah SWT untuk menyampaikan
ajaran-Nya kepada umat-Nya adalah ...

a. malaikat b. manusia C. jin d. rasul
6. Nabi pertama yang diutus oleh llah SWT adalah nabi ...

a. Adam as b. Idris as ¢. Muhammad SAW d. Hud

as

7. Rasul yang memiliki kesabaran hati yang luar biasa dalam melaksanakan
tugas sucinya disebut ...

a. ulil amri b. ululazmi c. ululazmu d. Ulul
ilmi
8. Pada dasarnya rasul terpelihara dari perbuatan dosa yang disebut dengan
istilah ...
a. maksum b. makmum ¢. mukmin d. muslim
9. Nabi dan rasul membimbing umat manusia ke ...
a. tempat yang ramai c. tempat yang terang
b. jalan yang benar d. Jalan yang ramai
10. Allah SWT mengutus para rasul dari kalangan manusia agar dapat ...
a. berperang c. menjalankan tugas
b. berkomunikasi d. berjuang

11. Allah memberi sifat-sifat yang istimewa kepada para rasul untuk
menjalankan tugasnya yaitu memimpin manusia agar hidup sesuai perintah
Allah, salah satu sifat wajib rosul adalah ...
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12.

13.

14.

15.

16.

17.

18.

19.

20.
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a. kizib b. fatanah c. khianat d. kitman
Semua rasul bertugas menyampaikan ajaran- ajaran yang telah

diwahyukan kepadanya, maka rasul bersifat ...

a. sidiq b. amanah c. tablig d. fatanah
Jumlah rasul yang termasuk ululazmi ada ...

a. 3 b. 4 c.5 d. 6
Berikut ini yang termasuk rasul ululazmi yaitu nabi ...

a. Adam as b. Idris as c. Nuh as d. Hud

as

Tongkat menjadi ular adalah mukjizat nabi ...

a. Musa as b. Isa as c. Nuh as d. Hud

as

Nabi Muhammad SAW, nabi Ibrahim as, nabi Musa as, nabi Isa as, nabi

Nuh as, termasul golongan rasul-rasul ...

a. ulul amri b. ululazmi c. ululalbab d. ululilmi
Berikut ini sikap yang sesuai dengan sifat wajib rosul amanah adalah ...

a. bila bicara berbohong c. bila bicara jujur

b. bila janji ingkar d. Bila janji menepatinya

Adit merupakan murid yang paling rajin belajar sehingga dia terkenal

sebagai murid yang cerdas di kelasnya. Perilaku adit mencerminkan bahwa
ia meneladani sikap terpuji para rosul. Hal tersebut sesuai dengan salah

satu sifat wajib rasul yaitu ...

a. sidiq b. amanah c. tablig d. fatanah
Pada jam istirahat Dika bergegas mengembalikan buku bacaan yang
dipinjamnya di perpustakaan. Perilaku Dika sesuai dengan salah satu sifat
rasul yaitu ...

a. sidiq b. amanah c. tablig d. fatanah
Salah satu contoh perilaku yang mencerminkan seseorang meneladani sifat
rasul adalah ...

a. memaafkan kesalahan teman

b. tidak mau memaafkan kesalahan teman

c. selalu berkata kasar

d. selalu mengejek teman
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP)

(Kelas Eksperimen)

Nama Sekolah : SDN Karanganyar 1

Mata Pelajaran : Pendidikan Agama Islam dan Budi Pekerti
Kelas/ Semester VIl

Materi : Beriman Kepada Rasul- rasul Allah SWT
Alokasi Waktu : 1 X 4 JP ( Pertemuan ke 1)

A. Kompetensi Inti (K1) :
KI-1 : Menerima, menjalankan, dan menghargai ajaran agama yang

dianutnya.

KI-2 : Menunjukkan perilaku jujur, disiplin, tanggung jawab, santun,
peduli, dan percaya diri dalam berinteraksi dengan keluarga,
teman, guru, dan tetangganya serta cinta tanah air.

KI-3 : Memahami pengetahuan faktual dan konseptual dengan cara
mengamati, menanya dan mencoba berdasarkan rasa ingin tahu

tentang dirinya, makhluk ciptaan Tuhan dan kegiatannya, dan benda-
benda yang dijumpainya di rumah, di sekolah dan tempat bermain.
KI-4 : Menyajikan pengetahuan faktual dan konseptual dalam bahasa yang
jelas, sistematis, dan logis dalam karya yang estetis, dalam gerakan yang
mencerminkan anak sehat, dan dalam tindakan yang mencerminkan
perilaku anak beriman dan berakhlak mulia.
B. Kompetensi Dasar dan Indikator Pencapaian Kompetensi

Kompetensi Dasar Indikator Pencapaian

1.3 Meyakini keberadaan Rasul Allah | 1.3.1 Menjelaskan pengertian beriman
dan Rasul Ulul ‘Azmi kepada Rasul Allah dan Rasul Ulul
‘Azmi

1.3.2 menerima keberadaan Rasul
Allah dan Rasul Ulul ‘Azmi

2.3 Menunjukkan sikap sabar dan 2.3.1 Mengimplementasikan sikap
jujur sebagai implementasi dari terpuji para Rasul Allah dan Rasul
pemahaman mengenal nama-nama Ulul ‘Azmi dalam kehidupan sehari-
Rasul Allah dan Rasul Ulul ‘Azmi. hari

C. Tujuan Pembelajaran
1. Siswa mampu menjelaskan pengertian beriman kepada Rasul Allah
dan Rasul Ulul ‘Azmi
2. Siswa mampu menerima keberadaan Rasul Allah dan Rasul Ulul
‘Azmi
3. Siswa mampu memahami tugas dan sifat Rasul Allah
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4. Siswa mampu menunjukkan sikap sabar dan jujur sebagai
implementasi dari pemahaman mengenal nama-nama Rasul Allah
dan Rasul Ulul ‘Azmi

. Materi Pembelajaran

Iman Kepada Rasul Allah SWT

. Metode Pembelajaran

1. Metode Bernyanyi

. Media dan Sumber Pembelajaran

1. Media : gambar pembelajaran

2. Sumber belajar : buku paket dan buku LKS
. Langkah-langkah Pembelajaran

100

Kegiatan Pembelajaran Waktu
Pendahuluan s Mempersiapkan beberapa media atau alat | 20
peraga yang akan digunakan dalam proses | menit
pembelajaran
% Mengucapkan salam, membaca doa,
membaca asmaul husna, mengabsen siswa,
menyapa siswa dan menyampaikan tujuan
pembelajaran
%+ Guru mengkondisikan kelas dalam suasana
kondusif untuk berlangsungnya
pembelajaran
¢+ Melakukan apersepsi materi sebelumnya
Kegiatan Inti % Mengamati 100
a) Siswa mengamati materi iman kepada | menit

X/
L X4

0

X/
**

rasul Allah dan ululazmi

b) Guru menyanyikan syair atau lagu yang
sebelumnya sudah disiapkan dan
disesuaikan dengan materi yang akan
disampaikan vyaitu berimana kepada
rasul-rasul Allah SWT

c) Siswa mengamati syair tersebut
kemudian siswa ikut menyanyikan syair
tersebut secara bersama-sama

Menanya

a) Guru mengajukan pertanyaan kepada
siswa mengenai materi beriman kepada
rasul-rasul Allah SWT

Mengeksplorasi

a) Guru mempersilahkan siswa untuk
mengekspresikan materi yang telah di
bahas  menggunakan  syair  yang
dinyanyikan.

Mengasosialisasikan

a) Setiap siswa bergantian maju ke depan
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menyanyikan materi yang telah di
lagukan.

b) Guru dan siswa menyanyikan kembali
lagu atau syair tentang materi tersebut

% Mengkomunikasikan

a) Setiap siswa mencoba menyanyikan
materi yang dilagukan secara bergantian
dengan teman sebangku.

b) Guru bersama siswa melakukan evaluasi
materi tersebut.

Penutup

% Menyimpulkan hasil pembelajaran hari ini

0

% Memberikan umpan balik positif dan
penguatan terhadap partisipasi siswa dalam
mengikuti pembelajaran

% Menutup kegiatan pembelajaran dengan doa

bersama

20
menit

H. Penilaian

1. Keaktifan selama pembelajaran
2. Menjawab pertanyaan yang diberikan
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP)
(Kelas Kontrol)

Nama Sekolah : SDN Karanganyar 1

Mata Pelajaran : Pendidikan Agama Islam dan Budi Pekerti
Kelas/ Semester VIl

Materi : Beriman Kepada Rasul- rasul Allah SWT
Alokasi Waktu : 1 X 4 JP ( Pertemuan ke 1)

A. Kompetensi Inti (K1) :
KI-1 : Menerima, menjalankan, dan menghargai ajaran agama yang

dianutnya.

KI-2 . Menunjukkan perilaku jujur, disiplin, tanggung jawab, santun,
peduli, dan percaya diri dalam berinteraksi dengan keluarga,
teman, guru, dan tetangganya serta cinta tanah air.

KI-3 : Memahami pengetahuan faktual dan konseptual dengan cara
mengamati, menanya dan mencoba berdasarkan rasa ingin tahu
tentang dirinya, makhluk ciptaan Tuhan dan kegiatannya, dan benda-

benda yang dijumpainya di rumah,  di sekolah dan tempat bermain.
KI-4 : Menyajikan pengetahuan faktual dan konseptual dalam bahasa
yang jelas, sistematis, dan logis dalam karya yang estetis, dalam
gerakan yang mencerminkan anak sehat, dan dalam tindakan
yang mencerminkan perilaku anak beriman dan berakhlak mulia.

B. Kompetensi Dasar dan Indikator Pencapaian Kompetensi

Kompetensi Dasar Indikator Pencapaian

1.3 Meyakini keberadaan Rasul Allah | 1.3.1 Menjelaskan pengertian beriman
dan Rasul Ulul ‘Azmi kepada Rasul Allah dan Rasul Ulul
‘Azmi

1.3.2 menerima keberadaan Rasul
Allah dan Rasul Ulul ‘Azmi

2.3 Menunjukkan sikap sabar dan 2.3.1 Mengimplementasikan sikap
jujur sebagai implementasi dari terpuji para Rasul Allah dan Rasul
pemahaman mengenal nama-nama Ulul ‘Azmi dalam kehidupan sehari-
Rasul Allah dan Rasul Ulul ‘Azmi. hari

C. Tujuan Pembelajaran
1. Siswa mampu menjelaskan pengertian beriman kepada Rasul Allah
dan Rasul Ulul ‘Azmi
2. Siswa mampu menerima keberadaan Rasul Allah dan Rasul Ulul
‘Azmi
3. Siswa mampu memahami tugas dan sifat Rasul Allah
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D.

E.

F.

G

4. Siswa mampu menunjukkan sikap sabar dan jujur sebagai
implementasi dari pemahaman mengenal nama-nama Rasul Allah
dan Rasul Ulul ‘Azmi

Materi Pembelajaran

Iman Kepada Rasul Allah SWT
Metode Pembelajaran
1. Metode ceramah
2. Metode diskusi
Media dan Sumber Pembelajaran
1. Media : gambar pembelajaran
2. Sumber belajar : buku paket dan buku LKS

103

. Langkah-langkah Pembelajaran
Kegiatan Pembelajaran Waktu
Pendahuluan s Mempersiapkan beberapa media atau alat | 20
peraga yang akan digunakan dalam proses | menit
pembelajaran
% Mengucapkan salam, membaca doa,
membaca asmaul husna, mengabsen siswa,
menyapa siswa dan menyampaikan tujuan
pembelajaran
%+ Guru mengkondisikan kelas dalam suasana
kondusif untuk berlangsungnya
pembelajaran
¢+ Melakukan apersepsi materi sebelumnya
Kegiatan Inti % Mengamati 100
a) Siswa mengamati gambar- gambar yang | menit

X/
L X4

berkaitan dengan materi iman kepada
rasul Allah dan ululazmi

b) Guru menyanyikan syair atau lagu yang
sebelumnya sudah disiapkan dan
disesuaikan dengan materi yang akan
disampaikan vyaitu berimana kepada
rasul-rasul Allah SWT

c) Siswa mengamati syair tersebut
kemudian siswa ikut menyanyikan syair
tersebut secara bersama-sama

Menanya

a) Guru mengajukan pertanyaan kepada
siswa mengenai gambar yang berkaitan
dengan berimana kepada rasul-rasul
Allah SWT

b) Peserta didik melakukan tanya jawab
mengenai gambar yang berkaitan
dengan berimana kepada rasul-rasul
Allah SWT

¢ Mengeksplorasi
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a) Guru membagi siswa ke dalam beberapa
kelompok

b) Setiap kelompok dipersilahkan mencari
penjelasan tentang materi berimana
kepada rasul-rasul Allah SWT dari
sumber belajar yang disediakan atau
dari sumber lain

c) Setiap  kelompok  mendeskripsikan
pendapatnya ke dalam buku tulis

%+ Mengasosialisasikan

a) Setiap  kelompok  siswa  saling
mendiskusikan hasil pencarian tentang
materi berimana kepada rasul-rasul
Allah SWT

% Mengkomunikasikan

a) Perwakilan dari masing-masing
kelompok membacakan hasil diskusi
yang telah di diskusikan

b) Kelompok Ilain menanggapi hasil
diskusi kelompok lainnya yang dipandu
oleh guru

c) Guru bersama siswa melakukan evaluasi
materi presentasi setiap kelompok

Penutup s+ Menyimpulkan hasil pembelajaran hari ini 20
% Memberikan umpan balik positif dan | menit
penguatan terhadap partisipasi siswa dalam
mengikuti pembelajaran
¢ Menutup kegiatan pembelajaran dengan doa
bersama
H. Penilaian

1. Keaktifan selama pembelajaran
2. Menjawab pertanyaan yang diberikan
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	1) Membuka aplikasi SPSS.
	2) Aktifkan variabel view => klik data view.
	3) Input data hasil uji instrument kedalam lembar kerja SPSS.
	4) Klik menu anlyze => correlate => bivariate.
	5) Pindahkan semua item 1 sampai pelayanan ke kotak yang ada di sebelah kanan, lalu centang pearson, two tailed dan flog significantcorrelation kemudian klik OK.
	Dalam menggunakan analisis software SPSS, butir soal instrumen dikatakan valid jika Corrented Item-Total Correlation lebih besar dari r tabel.

